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ABSTRAKT
Táto bakalárska práca sa venuje vytvoreniu laboratórnej úlohy zaradenej do predmetu
Komunikační systémy pro IoT. Prvú časť práce tvorí zoznámenie sa s problematikou IQRF
siete, jej topológiou a možnosťami siete. V práci je porovnaná IQRF technológia s ďalšími
IoT technológiami, ktoré sú často používané v tomto odvetví. Praktickú časť práce tvorí
samotný návrh modulu pre IQRF vysielač TR-72DA v tvare mini PCIe karty. Ďalšia časť
práce sa zaoberá vytvorením komunikácie s BPC-IoT doskou pomocou zbernice SPI.
Ako príklad sa využíva meranie teploty. Poslednou časťou práce je zadanie pre samotnú
laboratórnu úlohu. Prílohy obsahujú aj schémy a zdrojový kód programov BPC-IoT dosky
aj IQRF vysielača.

KĽÚČOVÉ SLOVÁ
Internet vecí, IQRF, LoRa, ZigBee, mesh, gateway, IQMESH protokol, uzol, oneskorenie,
payload, prenosová rýchlosť, dosah siete, vysielač, sieť, I2C, UART, SPI, mini PCIe, M2
key E, TR-72D

ABSTRACT
This bachelor’s thesis deals with creating a laboratory task integrated into the subject
of "Communication Systems for IoT." The first part of the thesis consists of familiarizing
oneself with the issues of the IQRF network, its topology, and the network’s capabilities.
The thesis compares IQRF technology with other IoT technologies commonly used in this
field. The practical part of the thesis comprises the design of a module for the IQRF
transmitter TR-72DA in the form of a mini PCIe card. Another part of the thesis deals
with establishing communication with the BPC-IoT board using the SPI bus, with tem-
perature measurement used as an example. The final part of the thesis is the assignment
for the actual laboratory task. The appendices also include schematics and source code
of programs for both the BPC-IoT board and the IQRF transmitter.
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tency, payload, data rate, network range, transmitter, network, I2C, UART, SPI, mini
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Úvod
Aktuálne sú často uplatňované v bežnom živote inteligentné technológie, smart
mestá či budovy, v ktorých sa využívajú inštalácie ako napríklad inteligentné par-
kovanie, osvetlenie či monitoring odpadového hospodárstva. Tieto inštalácie tvoria
veľký celok nazývaný Internet vecí. Sieť internetu vecí sa skladá z viacerých zariadení
ako sú senzory s dlhou výdržou pri batériovom napájaní, centrálne prvky - gateway,
ktoré spájajú sieť senzorov a internetové úložisko (cloud). Bez týchto zariadení by
internet vecí nemohol fungovať. V oblasti vývoja prvkov do internetu vecí sa už špe-
cializuje mnoho firiem a jednou z nich je aj IQRF Tech s.r.o. v Jičíne, ktorá vyvíja
technológiu IQRF. IQRF je bezdrôtová technológia stredného dosahu s paketovou
orientáciou, dlhou životnosťou a bezúdržbovosťou.

Cieľom tejto bakalárskej práce je zadefinovať teoretický základ a vytvoriť prak-
tické podklady pre laboratórnu úlohu IQRF modul pre meranie mesh sietí.

Prvou časťou bakalárskej práce je teoretický rozbor základných vlastností a pa-
rametrov IQRF technológie, ktoré sú následne v druhej kapitole porovnané s inými,
frekventovane požívanými technológiami pre internet vecí.

Pre spojenie IQRF vysielača a BPC-IOT dosky, ktorá bude napájať a komuni-
kovať s IQRF vysielačom a vykonávať merania IQRF siete, je potrebné navrhnúť
modul. Tento modul bude navrhnutý pre mini PCIe kartu použitím návrhového
softvéru Altium Designer a následne vyrobený firmou JLC PCB a ručne osadený
súčiastkami. Do modulu bude osadený aj IQRF vysielač naprogramovaný v jazyku
C. Modul s vysielačom bude vsunutý do mini PCIe slotu na BPC-IoT doske na-
programovanej v jazyku microPython. IQRF vysielač bude posielať snímané údaje
na koordinátor.

Laboratórna úloha sa nachádza v prílohe A, anglická verzia tejto úlohy je v prí-
lohe B, schéma, návrh dosky a súbory pre výrobu modulu v prevedení mini PCIe
karty v prílohe C, D a E. Zdrojové kódy k jednotlivým zariadeniam sú v prílohe F.
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1 IQRF technológia a jej základné znaky
Internet vecí (Internet of Things - IoT) je koncept, ktorý má snahu prepojiť veci
z bežného života s internetom pomocou senzorov a softvérov, ktoré sú takmer bez-
údržbové a majú nízku spotrebu elektrickej energie. V súčasnosti sa na sféru IoT
riešení špecializuje mnoho firiem, ktoré vyvíjajú technológie s rôznym spôsobom
a dosahom pokrytia oblastí. Medzi tieto technológie patrí aj platforma IQRF.

1.1 Úvod do IQRF
IQRF (Intelligent Quick Response Frequency) je bezdrôtová technológia a platforma
pre IoT orientovaná paketovo. Umožňuje posielať nízke množstvo dát s minimálnou
spotrebou elektrickej energie a maximálnou spoľahlivosťou. Technológia je vhodná
pre náročné aplikácie, ktoré si vyžadujú čo najnižšiu spotrebu elektrickej energie
ako sú batériou napájané inštalácie, aplikácie pre IoT, Smart Cities (Inteligentné
mestá). IQRF technológia bola vyvinutá v roku 2004 českou firmou MICRORISC
a v roku 2017 bola založená jej sesterská spoločnosť IQRF Tech s.r.o. v Jičíne,
ktorá sa zaoberá vývojom IQRF technológie a jej zariadení až do dnes a je hlavným
koordinátorom IQRF technológie vo svete [1], [2].

1.2 Základné parametre IQRF
IQRF technológia pracuje v nelicencovanom Sub-GHz ISM (industrial scientific me-
dical) rádiovom pásme (433, 868, 915 MHz) v závislosti od kontinentu alebo štátu
inštalácie. V Českej republike je používané 868 MHz pásmo. IQRF nepotrebuje
externú infraštruktúru ako sú mikrovlnné prepojenia alebo dlhé káblové vedenia.
Moduly IQRF technológie môžu pracovať v rôznych typológiách ako napr. bod -
bod, hviezda, ale najčastejšie je používaná v mesh topológii obr.1.1. Pôvodne bola
technológia IQRF využívaná v automatizácii budov, ale v posledných rokoch tech-
nológia prešla ďalším vývojom a stala sa konkurencie schopná aj vo väčších apli-
káciách. Na obr.1.1 je znázornený typický dizajn IQRF siete obsahujúci jednotlivé
uzly (senzory) v mesh topológii, gateway, cloud a pripojenie na internet (aplikácia
pre komunikáciu so svetom) [2], [3], [4], [5].
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Obr. 1.1: Dizajn IQRF siete

1.3 IQRF sieť

Technológia IQRF je dizajnovaná do meshovej topológie (IQMESH). Pri použití
topológie mesh je využitý smerovací mechanizmus, ktorý dokáže odstrániť nevý-
hody topológie hviezda a zvýšiť tak spoľahlivosť celej siete. Základným prvkom
siete je IQRF vysielač (transciever) tvorený malým modulom používaným k prenosu
dát. Vysielač obsahuje malú mikrokontrolérovú 8-bitovú jednotku (MCU) operujúcu
so vstavaným operačným systémom (OS) riadiacim prenos dát.

Jednotlivé funkcie prístupu sú do IQRF vysielača zadané dvoma možnými spô-
sobmi:

• Prvý spôsob je zadaný pomocou užívateľskej aplikačnej vrstvy používajúcej
preddefinované funkcie v OS. Funkcie je možné naprogramovať v programova-
com jazyku C, avšak táto možnosť nie je podporovaná sieťami IQMESH.

• Druhý spôsob je založený na trojvrstvovej IQRF architektúre s hardvérovým
profilom, ktorý je schopný používať softvérový aplikačný plug-in. Všetky zdroje
a služby môžu byť prístupné cez hardvérový profil. Hardvérový profil v realite
implementuje periférny prístup k zariadeniu nad OS.

Z uvedeného vyplýva, že programovanie nie je potrebné a funkcionalita je dosiahnutá
jednoducho riadením cez dátový tok.

Z tohto dôvodu je možné použiť dva rôzne rádiofrekvenčné komunikačné režimy:
• Sieťový - obsahujúci jeden koordinačný uzol spravujúci meshovú sieť zloženú

až z 239 uzlov pre jednu sieť. V takejto sieti sú dátové pakety prístupné len pre
tie uzly, ktorým sú adresované. Každý uzol preto vie slúžiť ako koordinátor
alebo spoločný uzol. Takto môže v jednej sieti byť pripojených až 65.000 pra-
covných uzlov, ktoré vedia na pozadí pracovať ako smerovače. Vďaka tomu je
podporovaných až 240 hopov na jeden paket. Cesta pre paket môže byť nájdená
a vytvorená automaticky ako smerovacia štruktúra s možnosťou vyhľadávania
trasy. Trasy sú vytvorené automaticky cez redundantné cesty v mesh sieti.

• Nesieťový - nepodporuje sieťové funkcie, je vhodný pre aplikáciu zhotovenú
z malého množstva zariadení peer-to-peer komunikáciou. Pri maximálnom
možnom rozsahu sú dátové pakety prístupné pre všetky zariadenia [2], [3], [6], [7].
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1.4 IQRF Gateway
Nad IQRF sieťou a jej uzlami môže prevziať kontrolu cloudový server. V takom
prípade je potrebné použiť v sieti bránu (gateway). Gateway poskytuje rozhranie
pre spojenie a komunikáciu medzi IQRF sieťou a a ostatnými sieťami podporujúcimi
internetovú konektivitu. IQRF aliancia zatiaľ vyvinula Wi-Fi, GSM a ethernetové
gateway. Každý gateway obsahuje senzor - uzol, ktorý slúži ako koordinátor pre os-
tatné uzly v sieti. Gateway potom umožňuje zber dát, prístup a kontrolu ostatných
zariadení. IQRF gateway vie byť implementovaný z Linuxových zariadení ako na-
príklad Raspberry Pi. Okrem toho sú podporované aj zariadenia bez operačného
systému ako napr. Arduino... [2], [3].

GatewayMesh
sieť

Cloud
Raspberry Pi,

Arduino,
PC

Obr. 1.2: Gateway v rôznych prevedeniach

1.5 IQRF Cloud
IQRF cloud je server, ktorý poskytuje okamžitú službu spojenia medzi používateľmi
a sieťou IQRF s použitím klient-server komunikácie. Zároveň sa na tomto serveri vy-
tvára úložisko údajov, ktoré sú dostupné aj po určitom čase v závislosti od kapacity
pamäte servera. Dáta sa odošlú zo senzoru na gateway a odtiaľ sú priamo nahraté
na server. Takto uložené dáta sú už dostupné priamo cez internetový prehliadač
alebo pomocou aplikácie [3].

1.6 IQMESH protokol
IQMESH (Inteligent Mesh) je patentovaný meshový komunikačný protokol použí-
vaný vrámci ekosystému technológie IQRF. Je navrhnutý na sprostredkovanie bez-
drôtovej komunikácie v mesh topológii, v ktorej každé zariadenie môže komunikovať
s okolitými zariadeniami a potenciálne slúžiť ako preposielací uzol na rozšírenie do-
sahu siete. Každý paket je smerovaný uzlami na pozadí neobmedzujúc ich funkciona-
litu. Tento proces je riadený operačným systémom a je nebadateľný pre užívateľa.
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IQMESH podporuje viaceré smerovacie štruktúry ako sú: úplný mesh, redukovaný
mesh, optimalizovaný mesh, strom... Smerovanie môže prebiehať staticky, a taktiež
môže byť pod úplnou kontrolou užívateľa. Dynamické časovanie s výberom počtu
krokov v sieti a voliteľným časovým úsekom umožňuje maximálnu priepustnosť s mi-
nimálnym rušením a spotrebou elektrickej energie. Efektivita a spoľahlivosť je do-
siahnutá pomocou takzvaného záplavového mechanizmu, ktorý funguje podobne ako
povodeň - informácia je na miesto doručenia poslaná viacerými možnými cestami
- podobne ako voda pri povodni zaplavuje miesta kadiaľ môže pretiecť. Kolíziám
v sieti sa predchádza pomocou systému Time Division Multiple Access, čo v pre-
klade znamená viacnásobný prístup s časovým delením. Aj napriek vyššie spome-
nutým vyspelým funkcionalitám je IQMESH implementovateľný do jednoduchého
a lacného zariadenia s limitovanými možnosťami.

Každé zariadenie v sieti má unikátne číslo - logickú adresu priradenú pri výrobe.
Smerovací algoritmus Discovered Full Mesh (objavovací plne meshový algoritmus)
využíva virtuálnu smerovaciu štruktúru, ktorá vzniká pri procese objavovania, kedy
koordinátor pridelí virtuálne smerovacie číslo do každého zariadenia, ktoré dokáže
smerovať. Na obr.1.3 je v ľavej časti zobrazená štandardná statická sieť, v ktorej
sú uzly adresované pomocou logickej adresy - N1, N2, ..., Ni. Na pravej strane je
pridaná virtuálna štruktúra (oranžovo znázornené zóny). Zóny sú vytvárané zo za-
riadení s rovnakým počtom potrebných hopov na prístup do koordinátora. Následne
sú v zónach pridelené virtuálne smerovacie čísla. Logická adresa je používaná pre de-
finovanie cieľového zariadenia a virtuálne smerovacie číslo je používané OS pre sme-
rovanie. Virtuálne smerovacie číslo je prideľované systematicky podľa vzdialenosti
uzla od koordinátora, čo uľahčuje prácu záplavovému algoritmu a taktiež aj iným
smerovacím algoritmom. Možné je tiež smerovanie pomocou logickej adresy, pretože
uzly môžu byť uložené v poradí podľa logickej adresy. V kombinácii s protizrážkovým
mechanizmom je vytvorený smerovací, efektívny a bezkolízny prenos.

Počas vyhľadávania koordinátor hľadá uzly pripojené k sieti, aby im bol schopný
prideliť unikátne virtuálne smerovacie číslo. Koordinátor zaháji proces vyhľadáva-
nia a všetky zariadenia, ktoré odpovedajú na výzvu koordinátora „Odpovedzte mi“
ich dostanú pridelené. Na základe prijatej odpovede a za predpokladu, že prepoje-
nie medzi uzlami a koordinátorom bolo symetrické, sú objavené smerovacie cesty
do uzlov a naspäť ku koordinátorovi. Všetky uzly majúce priame spojenie s koor-
dinátorom patria do Zóny 0 a sú dostupné bez smerovania. Koordinátor postupne
vytvára zóny so stúpajúcim poradovým číslom. Tieto zóny sú vytvárané tak, že všet-
kým uzlom z aktuálnej zóny je prikázané, aby našli svojich susedov so vzdialenosťou
1 hop. Tento algoritmus sa opakuje pokiaľ nie je dosiahnutá zóna, ktorá už nemá
koho objavovať. Táto zóna sa nazýva okrajová a všetky ostatné zóny tvoria Rou-
ting Backbone (smerovaciu chrbticu). Takýto proces objavovania sa pri aplikáciách
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inteligentných budov či miest vykonáva iba počas budovania siete, nakoľko pri ta-
komto type siete nenastávajú časté zmeny v sieti. Ak by nastali, musel by proces
objavovania prebehnúť opätovne.

Na rozdiel od iných technológii IQRF nepotrebuje zdieľať naprieč sieťou detailnú
informáciu o čase. Smerované pakety sledujú počet uskutočnených hopov, čo zod-
povedá príslušnej zóne a časovému úseku na základe virtuálneho smerovacieho čísla.
Spätné poradie sa zase využíva na preposielanie odpovedí z uzlov späť na koordi-
nátor. Tento mechanizmus s pridaním informácie o dĺžke časového okna vytvára
efektívnu synchronizáciu všetkých zariadení. Podporovaný je aj iný spôsob synchro-
nizácie a to dynamické časovanie založené na dĺžke paketu [2], [8], [9], [10], [11].
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Obr. 1.3: Logické adresy a virtuálne smerovacie čísla po objavovaní

1.7 Latencia - Oneskorenie

Dôležitým parametrom pre každú sieť je jej oneskorenie pri smerovaní. Tento para-
meter siete je rozdielny podľa preferencií danej inštalácie. Oneskorenie je odlišné
ak je preferovaná nízka úroveň oneskorenia s označením STD (Standard) alebo
nízka spotreba energie značená LP (Low Power). Pri STD je oneskorenie do 60 ms
a pri LP je oneskorenie o niečo vyššie - do 100 ms. Tieto módy s rôznym oneskorením
je možné aj kombinovať (STD+LP). Podľa pomeru ich kombinácie vzniká unikátna
hodnota oneskorenia z vyššie uvedeného intervalu 60 ms - 100 ms. STD+LP je
najčastejšie používaným módom v IQRF sieti, pretože tento mód umožňuje použí-
vateľom najideálnejšie nastavenia siete pre ich konkrétne využitie [10], [7].

1.8 Prenosová rýchlosť a payload

Dáta, ktoré zozbiera senzor v IoT sieti, nie sú veľkého rozsahu. Pri prenášaní dát
zo senzorov preto nie je potrebné dosahovať vysokú prenosovú rýchlosť. Prenosová
rýchlosť technológie IQRF je zdanlivo nízka. V závislosti od použitia konkrétneho
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IQRF modulu sa prenosová rýchlosť pohybuje okolo 19 až 20 kbps. Táto rýchlosť je
dostatočná pre aplikácie, ktoré preferujú parametre ako je vyšší dosah siete alebo
nižšia spotreba elektrickej energie. Maximálna prenosová rýchlosť siete môže byť tak-
tiež ovplyvnená konkrétnym prostredím inštalácie alebo nastavením prvkov v sieti.
V oblastiach s vysokým rušením je prenosová rýchlosť nižšia ako v oblastiach s níz-
kym zarušením pásma. To isté platí aj pre payload, ktorý pri ideálnych podmienkach
dosahuje veľkosť správy 64 bytov [4], [12].

1.9 Dosah siete IQRF
Maximálny dosah jedného IQRF vysielača je certifikovaný na 500 m voľného pries-
transtva, čo pri použití viac ako 200 zariadení v mesh topológii predstavuje rozlohu
až desiatky kilometrov štvorcových. Z tohto dôvodu IQRF sieť radíme do kategórie
WMAN (Wireless Metropolitan Area Network) obr. 1.4, kde je tento dosah zobra-
zený v porovnaný aj s dosahmi iných IoT sietí. Pri reálnej aplikácii s prekážkami sa
dosah rapídne znižuje a je potrebné prepojiť viacero IQRF sietí pomocou stredového
prvku ako, je to zobrazené na obr.1.5 [4], [13].
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Obr. 1.4: Porovnanie dosahu viacerých sietí z IoT odvetvia
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Obr. 1.5: Zlúčenie dvoch sietí

1.10 Spotreba elektrickej energie
IQRF zariadenia vedia pracovať v rôznych stavoch vzhľadom na spotrebu elektrickej
energie. Pri správnom použití a skombinovaní jednotlivých stavov vieme dosiahnuť
tak nízku spotrebu, že zariadenia nadobudnú mnohoročnú výdrž na AAA batérii.
Pre lepšiu predstavu technológia obsahuje tri základné stavy:

• Vysielanie, kde v závislosti na nastavenom výkone dosahuje najvyšší potrebný
napájací prúd 19 mA,

• Prijímanie, kde maximálny odoberaný prúd je približne 12 mA,
• Režim spánku, ktorý dokáže spotrebu zariadenia úplne minimalizovať až

na hodnoty menšie ako 1 µA a pri hlbokom spánku až na hodnoty menšie
ako 1 nA [14].

Viac režimov s detailnejšími popisom o spotrebe sa nachádza v tab.1.1

Modul TR-76D
Stav IQRF zariadenia Odber elektrickej energie

Vysielanie s maximálnym výkonom 19 mA
Vysielanie s minimálnym výkonom 8,4 mA
MCU beží a RF vypnuté 1,53 - 71,67 mA
MCU beží a RF úsporný režim 2,83 mA
Nízko energetické vysielanie LP 244 µA
Prijímanie s maximálnou úsporou XLP 15 µA
Prijímanie s nízkou latenciou STD 11,9 mA
Režim spánku >1 µA
Hlboký spánkový režim >100 nA

Tab. 1.1: Spotreba elektrickej energie konkrétneho IQRF modulu
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1.11 Bezpečnosť IQRF siete

Každá prenášaná informácia môže byť pre niekoho cenná alebo citlivá, preto je
dôležité, aby IQRF sieť mala dobrú ochranu pred útokmi alebo poškodením s cieľom
dostať sa ku prenášaným informáciám.

Poškodenie koncových uzlov je jedným z najčastejších a najškodlivejších útokov
na bezdrôtovú sieť so senzormi (WSN - wireless sensor network). Je to spôsobené
tým, že pri takejto sieti sú uzly prítomné takmer všade (ľahko prístupné miesta
bez ochrany) a majú obmedzenia v úložných a aj výpočtových oblastiach. Útočník
teda môže sieť odpočúvať bez akýchkoľvek priamych prekážok. Každý takýto útok
zacielený na koncové uzly môže spôsobiť zlyhanie v sieti.

Poškodenie koordinátora je ďalším častým spôsobom útoku na sieť, keďže každá
informácia z koncových uzlov prechádza práve týmto bodom. Koordinátor taktiež
zohráva hlavnú úlohu pri pripojení koncových bodov (senzorov) na gateway a ná-
sledne na internet.

Najčastejším terčom hekerov je gateway, pretože všetky prenášané informácie
z IQRF siete ňou prechádzajú. Hekeri útokom informácie ukradnú alebo ich zablo-
kujú.

Bezdrôtová komunikácia či celý systém je vystavený potenciálnemu útoku vzdu-
chom OTA (over-the-air). Z tohto dôvodu sa od verzie operačného systému 4.0 IQRF
aliancia zamerala najmä na bezpečnosť siete. Od tejto verzie je v IQRF operačnom
systéme implementovaná ochrana založená na priemyselných štandardoch a zais-
ťuje tak autorizovaný prístup k toku dát vzduchom. Konkrétne bol v operačnom
systéme implementovaný štandard AES-128 pre šifrovanie bezdrôtovej komunikácie.
Okrem šifrovania dát sa zvyšuje aj celková ochrana siete a zabraňuje sa falšovaniu
jednotlivých paketov.

V IQRF sieti existujú tri hlavné úrovne ochrany, ktoré sú založené na šifrovaní
AES-128:

• Šifrovanie prístupu: toto nezávislé šifrovanie sa vždy používa pri pripájaní
všetkých zariadení k sieti. Táto úroveň ochrany zabezpečuje, že k sieti majú
prístup len autorizované zariadenia a teda chráni sieť pred neautorizovaným
pridávaním uzlov do siete. Keď sa zariadenie pokúsi pripojiť k sieti, prístupové
šifrovanie pomáha overiť jeho autenticitu a autorizáciu.

• Šifrovanie komunikácie v sieti: je to bezpečnostná vrstva, ktorá používa
šifrovanie na všetky komunikácie v IQRF sieti. Tým je zabezpečené, že údaje
prenášané medzi jednotlivými zariadeniami v sieti sú bezpečné a nemôžu byť
jednoducho odchytené alebo poškodené neautorizovanými stranami. Šifrova-
nie siete pomáha chrániť integritu a dôvernosť údajov vymieňanými medzi
zariadeniami v sieti.
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• Šifrovanie používateľa: poskytuje dodatočnú úroveň bezpečnosti umožňujúc
šifrovanie údajových paketov (payload) pomocou používateľom definovaného
kľúča v aplikačnom kóde používateľa. Toto šifrovanie je voliteľné a môže byť
implementované na skrytie obsahu vybraných údajových paketov. Umožňuje
používateľom kontrolu nad šifrovaním konkrétnych údajov a poskytuje doda-
točnú úroveň bezpečnosti pre citlivé informácie [10], [15], [16], [17].

1.12 Zhrnutie parametrov IQRF siete
V tabuľke 1.2 sú spísané najdôležitejšie parametre IQRF siete. Tieto parametre sú
všeobecné a teda môžu sa odlišovať v závislosti od použitých zariadení alebo apli-
kovaných nastavení pre jednotlivé zariadenia napr. nastavenie vysielacieho výkonu
alebo oneskorenia pre daný vysielač či uzol.

IQRF
Veličina Jednotka Hodnota

Pracovná frekvencia MHz 433, 868, 916
Prenosová rýchlosť kbps 20
Max. dĺžka prenášanej správy byte 64
Max. dosah vo voľnom priestranstve m 1000
Modulácia - GFSK
Topológia - mesh
Oneskorenie ms 60 - 100
Max. počet uzlov na gateway - 65*103
Teoretický čas života na AAA batérii rok 5 - 10

Tab. 1.2: Prehľad parametrov IQRF siete
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2 Ďalšie riešenia IoT sietí
V IoT aplikáciách sa používajú okrem IQRF platformy ďalšie podobné technológie.
Pre porovnanie sú v práci použité technológie s podobnými parametrami ZigBee,
Bluetooth Low Energy a Wi-Fi HaLow. Taktiež zaujímavá je aj primárne úplne
odlišná sieť akou je LoRa, ktorá však už vie pracovať v mesh topológii.

2.1 LoRa
LoRa je technológia vyvinutá firmou Semtech a Microchip, ktorá má patentovaný
prístupový a kontrolný protokol LoRaWAN. Výhody technológie LoRa sú pozna-
teľné už v názve LoRa - Long Range - v preklade do slovenčiny dlhý dosah. Dosah
technológie LoRa je od 5 do 20 km na jeden gateway v závislosti od prostredia
v akom sa vysiela. LoRa využíva topológie typu hviezda, v ktorej je centrálny prvok
zároveň používaný ako gateway. Použitá topológia umožňuje použitie väčšieho množ-
stva senzorov (uzlov) na jeden gateway. Nevýhody siete LoRa vyplývajú z použitej
topológie. Pri poruche centrálneho prvku sa celá sieť stáva nefunkčnou. Doručenie
správ pri hviezdicovej topológii je taktiež menej spoľahlivé ako pri doručení správ
pri topológii mesh. Z tohto dôvodu prišla LoRa aliancia s inováciou a to použitím
mesh topológie alebo kombinovanej topológie mesh a hviezda.

LoRa ako bezdrôtová sieť využíva Direct Sequence Spread Spektrum (DSSS)
na fyzickej vrstve, čo umožňuje vysielať s využitím nižšieho vysielacieho výkonu
pre signál. Použitím FSK (Frequency Fhift Keying) modulácie sa mení frekvencia
pre nosné vlny podľa toho, aký bit vstupuje do modulácie (0 alebo 1) zo signálu,
ktorý sa práve moduluje. LoRa je schopná demodulovať a rozoznať signály, ktoré sú
niekoľko desiatok decibelov pod úrovňou šumu. Toto je možné vďaka FEC (Forward
Error Correction) mechanizmu, ktorý odoslaním paritných paketov v prípade po-
treby opraví stratený alebo poškodený dátový tok. Jeden paritný paket je vysielaný
pre skupinu N paketov.

LoRa pracuje v nelicencovanom sub GHz pásme rovnako ako IQRF čo v Európe
predstavuje 863 - 870 MHz. Dáta prenáša rýchlosťou 0,25 až 50 kbps. Veľkosť správy
v technológii LoRa môže byť z rozsahu 2 až 255 bajtov [18].
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LoRa
Veličina Jednotka Hodnota

Pracovná frekvencia MHz 443, 868, 780, 915
Prenosová rýchlosť kbps 0,3 - 40
Max. dĺžka prenášanej správy byte 243
Max. dosah vo voľnom priestranstve km 15
Modulácia - CSS
Topológia - hviezda, mesh
Oneskorenie ms >1000
Max. počet uzlov na gateway - 104
Teoretický čas života na AAA batérii rok 5 - 10

Tab. 2.1: Prehľad parametrov technológie LoRa

2.2 ZigBee

ZigBee je taktiež technológia pre bezdrôtovú komunikáciu s kratším dosahom po-
dobne ako IQRF. Využíva 2,4 GHz pásmo. ZigBee je veľmi spoľahlivá technológia,
keďže vo svojej architektúre implementuje zásady ako túto spoľahlivosť dosiahnuť.

Prvým bodom spoľahlivosti je implementácia štandardu IEEE 802.15.4 pre siete
s kratším dosahom, ale vysokou spoľahlivosťou. Základom tohto štandardu je mo-
dulácia OQPSK (Offset Quadranture Phase Shift Keying) a DSSS (Direct Sequence
Spread Spectrum), ktorých kombinácia dosahuje vynikajúce výsledky v prostrediach
s veľmi nízkym odstupom signálu od šumu.

Druhým bodom je používanie CSMA-CA (Carrier Sense Multiple Access Collie-
sion Avoidence) metódy. ZigBee najskôr pred vysielaním naslúcha kanálu a až ak
kanál je voľný, vysielanie môže začať. Táto metóda zabraňuje dvom zariadeniam
v sieti vysielať naraz a tak zabraňuje znehodnoteniu dát.

Tretí bod spoľahlivosti je používanie 16 bitového CRC (Cyclic Redundancy
Check) na každom pakete, čo má za následok kontrolu správnosti dátových bitov.
Každý paket má štyri možnosti opätovného odoslania. Ak sa ani na štvrtý krát
nepodarí paket doručiť, odosielací uzol je informovaný o probléme a je na ňom,
aby vyhľadal novú cestu na doručenie. V prípade ak sa nová cesta vyhľadať nedá,
odosielací uzol je informovaný, aby paket už nebol viacej posielaný.

Posledný bod spoľahlivosti, ktorý je používaný technológiou ZigBee, je samotná
topológia mesh, v ktorej ZigBee pracuje. Táto topológia zvyšuje svoj dosah a spo-
ľahlivosť pomocou viackrokového posielania paketov. Robustnosť siete je zvýšená
tak, že ak je nejaká cesta v sieti zahltená alebo poškodená, vyhľadá sa nová cesta
cez iné dostupné uzly.
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Vysielanie v 2,4 GHz pásme podľa štandardu IEEE 802.15.4. je možné až s preno-
sovou rýchlosťou 250 kbps. Avšak po zopakovaní šifrovania a dešifrovania a po plnom
využití mesh protokolu, priepustnosť siete je skôr okolo 25 kbps. Vysielače využívajú
polovične duplexné spojenie, čo znamená, že rovnakou cestou je realizované aj vy-
sielanie aj prijímanie, avšak obe funkcie nevedia byt realizované zároveň. Táto sku-
točnosť má taktiež za následok zníženie prenosovej rýchlosti z 250 kbps na 25 kbps.
V súčasnosti je dostupný štandard IEEE 802.15.4b. Ak by si ZigBee osvojilo tento
štandard, prenosová rýchlosť by mohla stúpnuť na 40 kbps.

Spotreba elektrickej energie zariadeniami v sieti je veľmi nízka, čo je výhodné
pri napájaní zariadení batériou, pretože pri výdrži batérií niekoľkých rokov je prak-
ticky údržba takéhoto zariadenia takmer nepotrebná. Nízku spotrebu elektrickej
energie znásobuje aj to, že Zigbee zariadenia využívajú podobne ako IQRF rôzne
režimy v závislosti na spotrebe. Taktiež komunikácia medzi zariadeniami neprebieha
neustále, ale len v určitých časových intervaloch.

ZigBee je nie len spoľahlivá technológia, ale aj bezpečná, keďže implementuje
štandard bezpečnosti AES-128 (Advanced Encryption Standard). Tento štandard
šifruje pakety spôsobom, ktorý je veľmi náročné prelomiť. Štandard AES je pova-
žovaný za jeden z najlepších bezpečnostných štandardov, zabezpečuje aj šifrovanie
paketov aj autorizáciu uzlov [19].

ZigBee
Veličina Jednotka Hodnota

Pracovná frekvencia GHz 2,4
Prenosová rýchlosť kbps 250
Max. dĺžka prenášanej správy byte 128
Max. dosah vo voľnom priestranstve m 300
Modulácia - BPSK, OQPSK
Topológia - hviezda, mesh, strom
Oneskorenie ms 16
Max. počet uzlov na gateway - 65*103
Teoretický čas života na AAA batérii rok 2

Tab. 2.2: Prehľad parametrov technológie ZigBee
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2.3 Bluetooth Low Energy
Bluetooth Low Energy (BLE) je bezdrôtová technológia s menším dosahom. BLE
využíva 40 kanálov (37 je použiteľných pre prenos dát) v 2,4 GHz nelicencovanom
frekvenčnom pásme. Táto technológia umožňuje komunikáciu s nízkou spotrebou
elektrickej energie, ktorá je možná vďaka kratším dĺžkam vlny použitého rádiového
signálu. BLE podporuje viacero komunikačných topológii, počínajúc jednoduchým
point-to-point, broadcast, ale najčastejšie sa používa mesh. Táto topológia umož-
ňuje, aby BLE bol schopný vytvoriť pomerne veľkú a stabilnú sieť s vysokou re-
dundanciou. BLE poskytuje aj vyspelú lokalizačnú službu pre vonkajšie podmienky,
teda vie presne zmerať a lokalizovať vzdialenosť susediacich zariadení a podľa toho
uľahčiť nastavenia používateľovi. Podobne ako vyššie opisované IQRF aj BLE po-
užíva GFSK moduláciu. Nízku spotrebu elektrickej energie podporuje aj pomerne
nízky vysielací výkon, ktorý dosahuje maximálne hodnoty 100 mW. Takýto vysie-
lací výkon je však absolútne postačujúci, pretože senzitivita prijímača je menej ako
-70 dBm a v závislosti od módu až menej ako -82 dBm [20].

Bluetooth Low Energy
Veličina Jednotka Hodnota

Pracovná frekvencia GHz 2,4
Prenosová rýchlosť kbps 2000
Max. dĺžka prenášanej správy byte 251
Max. dosah vo voľnom priestranstve m 400
Modulácia - GFSK
Topológia - mesh
Oneskorenie ms 6
Max. počet uzlov na gateway - 65*103
Teoretický čas života na AAA batérii rok 1 - 2

Tab. 2.3: Prehľad parametrov technológie Bluetooth Low Energy

Obr.2.1 graficky znázorňuje využitie a rozdiely medzi technológiou Bluetooth
a Bluetooth Low Energy. Výhodou je, že novšie verzie smartfónov, tabletov či note-
bookov podporujú už obe tieto technológie.
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malý obnos dát, nízka spotreba

Obr. 2.1: Bluetooth v porovnaní s BLE

2.4 Wi-Fi HaLow
Wi-Fi HaLow je názov pre nízko rýchlostnú, úspornú Wi-Fi s veľkým dosahom. Táto
technológia využíva licencované pásma s frekvenciou pod 1 GHz. V praxi to znamená
dlhší dosah signálu a lepšiu priepustnosť cez prekážky až do vzdialenosti 1 km.
Pri týchto využívaných frekvenčných pásmach nie je potrebné vysielať s vysokým
výkonom, čo má za následok zlepšenie úspory elektrickej energie. Wi-Fi HaLow
pracuje najčastejšie v mesh topológii [21].

Wi-Fi HaLow
Veličina Jednotka Hodnota

Pracovná frekvencia MHz 900
Prenosová rýchlosť kbps >150
Max. dĺžka prenášanej správy byte
Max. dosah vo voľnom priestranstve km >1
Modulácia -
Topológia - mesh
Oneskorenie ms
Max. počet uzlov na gateway - 8000+
Teoretický čas života na AAA batérii rok

Tab. 2.4: Prehľad parametrov technológie Wi-Fi HaLow
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Obr. 2.2: Pokles prenosovej rýchlosti jednotlivých technológii pre IoT v závislosti
od vzdialenosti od vysielača
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3 Návrh technického riešenia modulu pre vy-
sielač

Pre našu prácu bol vybraný a použitý IQRF vysielač TR-72D, ktorý sa na dosku
aplikuje pomocou konektoru pre SIM kartu. Pre pripojenie vyrábaného modulu sú
dostupné dve zbernice M2 E-key a PCI-Express. Na týchto zberniciach je možné
komunikovať a prenášať informácie pomocou viacerých protokolov SPI, UART a I2C.
Dostupné zbernice a protokoly sú nižšie popísané a porovnané.

3.1 IQRF vysielač TR-72D
V module je použitý IQRF vysielač TR-72D s integrovanou PCB (Pinted Circuit
Board) anténou priamo na doske. Tento vysielač vysiela podľa nastavenia na frek-
vencii 868 MHz alebo 916 MHz. Vysielač je možné vsunúť do konektoru na SIM
kartu, vďaka jeho malým rozmerom 31.8 mm x 14.9 mm x 3.3 mm (d x š x v).
Výhodou tohto vysielača je, že obsahuje vstavaný regulátor napätia. Pre labora-
tórne použitie nám postačuje verzia s integrovanou PCB anténou, nakoľko nie je
potrebné pokrytie rozsiahlych oblastí. Na obr. 3.1 je znázornená bloková schéma
tohto vysielača [22], [23], [24].

RF

EEPROM

Teplotný
senzor

Regulátor
napätia LDO

3,1 - 5,3 V

MCU

OS

Užívateľská
aplikácia

3V

6x I/O, SPI, UART, I2C, PWM,
A/D, Komparátor

Obr. 3.1: Bloková schéma vysielača
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3.1.1 Technické parametre IQRF vysielača TR-72D

Nižšie sú uvedené technické parametre použitého vysielača TR-72D, ktoré udáva
výrobca v technickom popise. Tieto parametre sú dôležité pre správnu voľbu vysie-
lača pre danú inštaláciu (napr. teplota okolia v mieste použitia vysielača ...) a tak-
tiež pre tvorbu obvodu, v ktorom bude IQRF vysielač použitý (napr. napájacie
napätie ...) [24].

Veličina Jednotka Hodnota
Napájacie napätie V 3.1 až 5.3
Výstupné napätie V 3
Výstupný prúd mA 60
Pracovná teplota °C -40 až +85
Odoberaný prúd počas hlbokého spánku uA 1.7
Odoberaný prúd počas spánku uA 2.3
RF spánok mA 1.95
RF pripravený mA 2.8
RX STD mA 12.1
RX LP uA 260
RX XLP uA 18.5
TX mód mA 8.3 až 25
Spotreba LED na jednu diódu mA 2
RF pásmo pre Európu MHz 868
RF modulácia - GSFK
Maximálna prenosová rýchlosť kbps 19.8
Efektívny vyžarovací výkon Dbm 2
Dosah pokrytia (voľné priestranstvo) m 500

Tab. 3.1: Technické parametre vysielača TR-72D
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3.1.2 Vnútorné zapojenie TR-72D

Na obr. 3.2 je znázornená schéma vnútorného zapojenia použitého IQRF vysielača
TR-72D s integrovanou PCB anténou. Vysielač TR-72D obsahuje 8 bitový mikro-
kontrolér PIC16LF1938-I/MV, ktorý riadi vysielač, LDO regulátor vstupného a vý-
stupného napätia MCP1700, snímač teploty MCP9808, 256 kbit EEPROM 24AA256
a RF IC SPIRIT1 [24].
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Obr. 3.2: Vnútorné zapojenie IQRF vysielača TR-72D
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3.1.3 Vývody vysielača TR-72D a ich funkcionalita

V tabuľke 3.2 je uvedená funkcionalita jednotlivých pinov vysielača TR-72D. Vlast-
nosti jednotlivých pinov sú taktiež dôležitou informáciou pri návrhu obvodu pre daný
vysielač. Vysielač TR-72D disponuje pinom pre napájanie obvodu (C3), zemniacim
pinom (C4). Ostatné piny slúžia na komunikáciu s vysielačom podľa zvoleného typu
komunikácie.

C1 IO/ADC/C-IN
všeobecný I/O pin
analógový A/D vstup
vstup komparátora

C2 IO/VOUT
všeobecný I/O pin
výstup +3 V z LDO

C3 VIN vstup pre napájacie napätie

C4 GND zemniaci pin

C5 IO/ADC/TX/-SS/PWM/COUNT

všeobecný I/O pin
SPI sleave select
analógový A/D vstup
výstup komparátora
UART TX
PWM výstup
programovateľný pull-up a wake up

C6 IO/SCK/SCL
všeobecný I/O pin
SPI clock vstup
I2C clock

C7 IO/SDI/SDA
všeobecný I/O pin
SPI dáta
I2C data

C8 IO/RX/SDO
všeobecný I/O pin
SPI dátový výstup
UART RX

Tab. 3.2: Funkcionalita jednotlivých kontaktov vysielača TR-72D
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3.1.4 Dosah pokrytia vysielačom TR-72D

Pokrytie vysielačom sa líši v závislosti na rôznych parametroch konkrétnej inštalá-
cie. V prípade obkolesenia vysielača predmetmi ako sú napríklad veľké batérie alebo
kovové predmety sa vyžarovaný signál odráža naspäť a následne pôsobí proti sig-
nálu vysielača, a tým znižuje jeho dosah. Dosah vysielača je taktiež ovplyvniteľný
softvérovo. Vysielací výkon vysielača je možné nastaviť pomocou výberu z ôsmich
úrovní. Veľký vplyv na dosah vysielača má orientácia a uloženie samotného vysie-
lača, pretože vysielacia charakteristika antény nie je na všetky smery rovnaká ako
je vyobrazené na obr.3.3 [24].

IQRF
Vysielač

PCB
Anténa

IQRF Vysielač

PCB Anténa

A) Horizontálne
uloženie vysielača

B) Vertikálne 
uloženie vysielača

Obr. 3.3: Tvar dosahu vysielača pri rôznom uložení

Poznámka: Oranžová čiara znázorňuje tvar oblasti pokrytej vysielačom.

3.2 Konektor vo formáte SIM karty KON-SIM-02
KON-SIM-02 je konektor určený na pripojenie IQRF vysielačov. Je kompatibilný
s mnohými modelmi, vrátane modelu TR-72Dx, ktorý je v tejto práci použitý. Ko-
nektor je určený na pájkovanie priamo na dosku. Je zhotovený z odolného plastu
a výrobca deklaruje výdrž 10 000 pripojení. Kontakty sú vyrobené z bronzu s prida-
ním fosforu a kontaktné plochy sú zase vyrobené z pozláteného niklu. Prechodový
odpor kontaktov je určený maximálne na 100 MΩ, ale ideálna hodnota prechodového
odporu je 50 MΩ. Konektor je dimenzovaný na prúdy do 0,5 A. Pracovná teplota
tohto konektoru je široká a to v rozpätí od -40 až do +85 °C [25], [26].
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Obr. 3.4: SIM konektor pre pripojenie vysielača k modulu

3.3 Gateway GW-USB-06
Gateway GW-USB-06 je gateway alebo aj koordinátor, ktorý vychádza z TR-7xD
architektúry a je priamo prepojiteľný do počítača prostredníctvom USB rozhrania.
Tento gateway je určený na prepojenie počítača so sieťou IQRF zariadení. Výhodou
tohto zariadenia je to, že používateľ je schopný naprogramovať si vlastné špecifické
funkcie pre svoje využitie. Gatway má taktiež viacero pokročilých funkcii ako sú
diagnostický prípravok pre aplikácie, bezdrôtový programátor (RFPGM) pre vysie-
lače a RTCC (hodiny s reálnym časom). Vysielací výkon koordinátora je 11 dBm
a jeho maximálna prenosová rýchlosť je 19,836 kbps [27].

Obr. 3.5: IQRF USB koordinátor
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3.4 Zbernica M.2 key E
M.2 je štandard, ktorý sa používa na pripojenie rozširujúcich kariet v počítačoch
a iných zariadeniach priamo na ich základných doskách. M.2 - je náhrada za mSATA
rozhranie, ktoré bolo Intelom predstavené v roku 2012. Použitie tohto rozhrania je
veľmi rôznorodé, pretože je schopné prenášať rôzne signály ako sú SATA, USB alebo
PCIe, čo umožňuje zariadeniam využívajúcim toto rozhranie rozšíriť svoje možnosti
o siete WLAN, Bluetooth a pod. Veľmi často sa používa toto rozhranie na pripojenie
SSD disku v notebooku alebo inom zariadení. Moduly M.2 sú kompaktné a majú
veľmi flexibilné vlastnosti vhodné pre merania. V praxi sa v elektronických zaria-
deniach používa mnoho dostupných druhov konektorov tohto rozhrania označených
pomocou slovíčka key (kľúč) v kombinácii s veľkým písmenom abecedy. Jednotlivé
prevedenia je možné aj navzájom kombinovať. Na doske použitej v práci je do-
stupné prevedenie M.2 key E. Toto prevedenie kontaktov rozhrania sa skladá z 12
a 19 kontaktných plôch, ktoré sú oddelené medzerou. Označenie key E neznamená
len rozdielny vzhľad konektora, ale taktiež aj podporu iného množstva a druhu pre-
nosového signálu. M.2 key E podporuje prenos 2x PCIe a USB signál [28], [29].

Obr. 3.6: Zbernica M.2 key E na BPC-IOT doske
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3.5 Zbernica mini PCI-Express
Mini PCI-Express (PCIe) je zbernica, ktorá je v dnešnej dobe veľmi často pou-
žívaná v počítačoch a iných elektronických zariadeniach vyžadujúcich pripojenie
externého zariadenia s vysokou prenosovou rýchlosťou. PCIe zbernica je využívaná
na duál-simplexné, point-to-point nízkonapäťové sériové spojenia. Prenos signálu je
zabezpečený vysoko-rýchlostne až 2,5 Gbit za sekundu s 8/10 bitový kódovaním,
aby sa do dátového toku vložil hodinový signál. Na prenosovej strane sú paralelné
dáta posunuté sériovo a na prijímacej strane sú zase dáta posunuté do registrov po-
užívaných pre paralelný výstup dát. Na tejto strane prijímač taktiež znovu obnoví
hodinový signál prenášaný s dátami. Kanál PCIe je tvorený vysielacím a prijíma-
cím nízkonapäťovým diferenciálnym signálnym párom. Pakety s dátami sú posie-
lané simplexne s frekvenciou 2,5 GHz. Vysielací aj prijímací kanál prenášajú dáta
s rýchlosťou 250 MBps, čo v kombinácií tvorí 500 MBps. Prenos môže byť tvorený
viacerými kanálmi v závislosti od prevedenia x1, x4, x8, x16 a x32. Toto prevedenie
má potom aj vplyv na spôsob použitia. Najčastejšie používané prevedenia sú x1
pre desktopy, x4 pre servery a x16 je často využívaná grafickými kartami. Riadiace
impedančno diferenciálne stopy umiestnené na doske sú 100 Ω. Prenášaný signál
dosahuje rôznu amplitúdu v závislosti od významu signálu. Prvý bit je prenášaný
s amplitúdou viac ako 800 mV a každý ďalší bit má amplitúdu 500 mV. Každá matica
PCIe je navrhnutá s autokonfiguráciou, to znamená, že ak je pripojené zariadenie
s menšou zbernicou, piny sú automaticky rozpoznané a informácie sú distribuované
správne [30].

Obr. 3.7: Zbernica mini PCI-Expres na BPC-IOT doske
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3.6 Rozhranie I2C
I2C je zbernica, ktorá bola vyvinutá firmou NXP Semiconductors. I2C je zbernica,
komunikujúca za použitia dvoch vodičov, radiaca sa medzi jednoduché zbernice.
Komunikácia po zbernici prebieha synchrónne, a preto je jeden z vodičov označený
SCL (Synchronization CLock) a druhým vodičom sú prenášané dáta. Tento vodič
nesie označenie SDA. Pripojené zariadenia pracujú v režime s otvoreným kolektorom
(open drain). Pri pripojení takéhoto zariadenia sa využívajú pull-up rezistory, ktoré
sú pripojené medzi napájacím napätím a jedným z vodičov tejto zbernice. Väčšinou
sa využívajú rezistory s odporom 4700 ohmov (4k7). Takéto zapojenie v obvode za-
bezpečí to, že ľubovolné zariadenie môže v ktoromkoľvek časovom okamihu zmeniť
hodnotu na zbernici tak, že žiadne zariadenie by nemalo byť poškodené. Základná
stavba tejto zbernice sa skladá z minimálne jedného master zariadenia riadiaceho
komunikáciu, ktorá prebieha na zbernici a generujúceho hodinový CLK (clock) sig-
nál a jedného zariadenia typu slave, ktoré reaguje na dáta od master zariadenia.
Zariadenie typu slave je väčšinou nejaké zariadenie na periférii.

Ak master zariadenie chce začať komunikáciu vyšle štartovaciu sekvenciu, ktorá
počas vysokej úrovne SCL zmení SDA do nízkej úrovne, následne sa do nízkej úrovne
zmení aj SCL. Táto štartovacia sekvencia je potrebná, lebo v pokojovom režime sú
oba kontakty v logickej 1, čiže vo vysokej úrovni. Následne je odoslaná 8 bitová
adresná sekvencia, ktorá určí akým smerom bude komunikácia pokračovať. Master
zariadenie počas deviateho hodinového impulzu nechá SDA vo vysokej úrovni. SDA
je stiahnuté do nízkej úrovne až v okamihu, keď je rozpoznané nejaké slave zaria-
denie, ktoré je správne adresované a je pripravené na komunikáciu. Tento proces sa
nazýva potvrdenie (Acknowledge), z čoho pochádza aj skratka tohto bitu (ACK).
Tento bit je používaný po každom komunikačnom bite. Jeho funkciou je potvrdiť
schopnosť ďalšej komunikácie, ktorá je signalizovaná nízkou úrovňou ACK. Ak by
ACK neskončilo v nízkej úrovni, komunikácia bude prerušená a ukončená. Komu-
nikácia sa ukončuje vyslaním sekvencie stop (počas vysokej úrovne SLC je SDA
uvoľnené) [31].

MASTER SLAVE
SDA

SCLK

Obr. 3.8: Architektúra I2C
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3.7 Rozhranie UART

Komunikačný protokol UART (Universal Asynchronous Reciever-Transmitter) je
asynchrónneho charakteru, ktorý vie pracovať v plne duplexnom režime. UART je
často používaný protokol v telekomunikačných a kontrolných systémoch. UART ko-
munikuje po dvoch signálových trasách, aby bolo dosiahnuté práve plne duplexné
spojenie. Komunikačné cesty sú označené RXD a TXD. Architektúra komunikačného
protokolu UART sa skladá z generátoru prenosovej rýchlosti, prijímacieho a vysie-
lacieho modulu. Generátor prenosovej rýchlosti má za úlohu urýchliť asynchrónny
sériový prenos dát. Generátor prenosovej rýchlosti pracuje ako rozdeľovač hodino-
vého signálu. Prijímací modul prijíma dáta prichádzajúce na kontakty tohoto mo-
dulu. Začiatok prijímania signálu je označený prechodom vysokej úrovne 1 do nízkej
úrovne 0. Vysielací modul mení dáta z paralelných na sériové a pridáva kontrolné
bity. Z časovacieho diagramu UART protokolu je zrejmé, že stav nečinnosti je počas
vysokej úrovne signálu. Zmena tejto úrovne na nízku značí začiatočný bit, nasle-
dovných 8 bitov sú prenášané dáta. Po prenášaných dátach nasleduje koncový bit,
ktorým je zaznačené to, že dáta už boli spracované. Po tomto bite môže zariadenie
znova prejsť do stavu nečinnosti do tzv. idle mode [32].

UART 1 UART 2
Generátor
prenosovej

rýchlosti

TX RX

RX TX

Generátor
prenosovej

rýchlosti

Obr. 3.9: Architektúra UART

3.8 Rozhranie SPI

SPI (Serial Peripheral Interface) je spôsob komunikácie založený na dvoch moduloch
master a slave. SPI protokol využíva 3+N ciest, kde pre N platí, že udáva počet slave
modulov. Tieto cesty zastávajú funkcie MOSI (Maste Out Slave In), MISO (Master
In Slave Out), SCLK (Slave Clock) a SS (Slave Select).

Architektúra komunikačného protokolu SPI je rozdelená do troch blokov:
• Generátor hodinového signálu
• Master modul
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• Slave modul
Vyššie uvedené cesty MOSI, SS a SCLK sú súčasťou práve Master modulu. MOSI
cesta je využívaná na komunikáciu mastru so slave. MISO je jediná cesta riadená
slave modulom, používaná na výstup informácií z daného modulu (senzoru). Frek-
venciu poskytovania dát slave modulom určuje SCLK master [32].

SPI Master SPI Slave

Generátor hodinového
signálu

MOSI

SCLK

SS

MISO

Obr. 3.10: Architektúra SPI

3.8.1 SPI v IQRF

Pre komunikáciu s využitím SPI v zariadeniach technológie IQRF je dôležité správne
implementovať štruktúru odosielanej správy napr. od mastra. Táto štruktúra obsa-
huje niekoľko bajtov na začiatku každej správy, ktoré prikazujú slave zariadeniu ako
má so správou postupovať v ďalšom spracovaní. Základným delením SPI paketov je
paket typu SPI_CHECK a SPI_CMD.

SPI_CHECK neobsahuje žiadne telo správy, iba sa dotazuje na aktivitu opačnej
strany v SPI komunikácii. V praxi je tento paket používaný veľmi často a zariadenia
si vymieňajú informácie o svojej aktivite približne každých 10 ms. Implementácia
paketu SPI_CHECK je pomerne jednoduchá, pretože celý paket je reprezentovaný
iba jedným znakom a to v hexadecimálnom tvare čísla 0 - (0x00) viď. obr.3.11.

SPI_CHECK

0x00

Obr. 3.11: SPI_CHECK paket
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SPI_CMD je už na implementáciu o čosi náročnejší, pretože tento paket ob-
sahuje už viacero častí viď. obr.3.12. Prvou časťou je informácia o tom, že je to
read/write SPI_CMD paket, čo je reprezentované prvým hexadecimálnym znakom
(0xF0). Druhým číslom v pakete je takzvaný PTYPE, ktorý je tvorený 8 bitovým
číslom viď. obr.3.13. Bit s číslom 7 má hodnotu 1, ak sa majú dáta prepisovať alebo
0 v prípade, že chceme aby tieto dáta nezmenili predošlú hodnotu údajov. Ostat-
ných 7 bitov vyjadruje dĺžku dát v správe (SPIDLEN - 1 až 64 bitov), ktorá bude
nasledovať. Ďalších n znakov je samotná správa - napríklad odosielaná teplota. Tieto
znaky správy sa označujú ako:

𝐷𝑀1, 𝐷𝑀2, ..., 𝐷𝑀𝑆𝑃 𝐼𝐷𝐿𝐸𝑁

Predposledným znakom v pakete je kontrolný znak CRCM, ktorý je vypočítaný ako:

𝑆𝑃𝐼_𝐶𝑀𝐷 𝑥𝑜𝑟 𝑃𝑇𝑌 𝑃𝐸 𝑥𝑜𝑟 𝐷𝑀1 𝑥𝑜𝑟 𝐷𝑀2 𝑥𝑜𝑟 ... 𝑥𝑜𝑟 𝐷𝑀𝑆𝑃 𝐼𝐷𝐿𝐸𝑁 𝑥𝑜𝑟 0𝑥5𝐹

Takto vytvorený paket je pripravený na prenos dát z mastra do slave zariadenia,
ktorý je v našom prípade realizovaný prenosom dát z Raspberry Pi pico (master)
do IQRF vysielača (slave). [33]

SPI_CMD PTYPE DM1 DM2 ... DMSPIDLEN CRCM

Obr. 3.12: Paket SPI komunikácie v IQRF

b7 b6 b5 b4 b3 b2 b1 b0

CTYPE SPIDLEN

Obr. 3.13: Tvorba znaku PTYPE

3.9 Návrh obvodu pre IQRF modul
V nasledujúcich podsekciách sú popísané základné bloky, ktoré sú potrebné pre správne
napájanie a komunikáciu IQRF modulu a dosky BPC-IOT, na ktorej je modul osa-
dený. Pre pripojenie IQRF vysielača a dosky BPC-IOT bola vybraná karta v pre-
vedení mini PCIe.

Zapojenie modulu bolo navrhnuté podľa odporúčaní výrobcu. Schéma tohto
zapojenia bola navrhnutá pomocou programu Altium Designer. Výsledná schéma
IQRF modulu sa nachádza v prílohe C.
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3.9.1 Napájanie

Pri napájaní je dôležité dbať na precíznosť, hlavne ak je použité napätie Z DC/DC
meniča alebo pulzného zdroja, pretože tým vieme zabrániť vzniku ďalších kompliká-
cií. Použitý vysielač obsahuje vstavaný napäťový regulátor (LDO) s malými stratami
(obr. 3.14), ktorého vstupné napätie by malo byť z rozsahu 3,1 V až 5,3 V. Výstupné
napätie tohto regulátora je +3 V s toleranciou 60 mV, ktoré je určené hlavne na na-
pájanie vnútorných obvodov vysielača. Výhodou vstavaného regulátora napätia je
externý výstup napätia pre napájanie prídavných obvodov až do odberu 100 mA [34].

MCP1700
2 +3 VVIN 3

GND
1

Obr. 3.14: Regulátor napätia vstavaný vo vysielači

3.9.2 Stabilizácia napätia (odstránenie spätnej väzby)

Spätná väzba sa odstraňuje, aby sa zabezpečilo dostatočne stabilné vstupné napätie
bez nežiadúcich emisií. Napájací zdroj musí byť dostatočne stabilným, nakoľko po-
čas vysielania a prijímania je odber elektrickej energie nestály a kolíše v závislosti
na výkone. Neschopnosť zdroja dodávať konštantné napätie by ovplyvnilo celkové
správanie vysielania a prijímania, ako sú napr. dosah či iné vysielacie alebo prijíma-
cie parametre.

Stabilitu zdroja vieme zabezpečiť pripojením stabilizačných kondenzátorov na prí-
vody napätia pre vysielač a uzemňovací kontakt. Stabilizačné kondenzátory by mali
byť pripojené čo najbližšie ku kontaktom vysielača. Typ a veľkosť kondenzátorov
je potrebné vyberať podľa typu aplikácie a kvality prívodného zdroja napätia. Naj-
častejšie je používaná dvojica tantalového kondenzátora s hodnotou okolo 10 𝜇F
a keramického kondenzátora s kapacitou z rozmedzia 100 nf až 1 𝜇F. Ak chceme od-
strániť rušivé frekvencie, nimi spôsobené prechodové prúdy a zvlnenia z frekvencií
blízkych GHz, je potrebné ešte pridať kondenzátor s nízkou kapacitou - iba nie-
koľko desiatok pF. Pravidlom by malo ostať to, že čím nižší predradný kondenzátor
je pripájaný do obvodu, tým by mal byť pripojený bližšie ku napäťovému vstupu
do vysielača [34].
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Obr. 3.15: Stabilizácia napätia

3.9.3 Filtrácia rušenia

Dôležitou vlastnosťou napájacieho zdroja je, aby dokázal zabrániť šíreniu precho-
dového prúdu výstupnej frekvencie cez vedenie elektrickej energie. Z tohto dôvodu
je potrebné dodržiavať optimálne rozloženie súčiastok na doske plošných spojov.
Správne filtrovaný musí byť aj napájací zdroj. Pre filtračný okruh platí zásada,
že by mal byť umiestnený čo najbližšie ku vstupu napätia do vysielača. Pri napájaní
zo zdroja s predpokladom už vyfiltrovaného napätia tento blok možno vynechať [34].

3.9.4 Odpájanie (hardwerový reset)

Ak je IQRF vysielač uložený na ťažko dostupnom mieste, pri poruche alebo novom
nastavení, je vhodné doplniť modul o funkciu vzdialeného resetu. Keďže mini PCIe
karta disponuje kontaktom s privedeným resetovacím signálom, dosiahnutie funkcie
vzdialeného resetu je pomerne jednoduché. Na tento jednoduchý obvod použijeme
komplementárne zapojenia MOSFET tranzistorového páru. Pre jednoduchosť je mo-
dul vybavený aj tlačidlom pre reset vysielača manuálne priamo na doske. Súčasťou
obvodu je aj odpor s nulovou hodnotou pre znefunkčnenie daného obvodu kvôli
neskorším vývojovým potrebám. V obvode je tiež zakomponovaná zelená luminis-
cenčná dióda pre signalizáciu funkčnosti privedeného napájacieho napätia. Zapojenie
tohoto obvodu je na obr.3.16 [34].
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Obr. 3.16: Hardwérový reset
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4 Realizácia hardvéru laboratórnej úlohy
Technická realizácia laboratórnej úlohy obnáša výrobu modulu s úpravou jeho roz-
merov, osadenia modulu súčiastkami, vybavenie modulu IQRF vysielačom a osade-
nie modulu s vysielačom do slotu mini PCIe karty na BPC-IoT doske. Táto doska
musí byť správne vybavená jumper prepojkami pre funkčnosť pripojených zariadení.
V neposlednom rade musí byť ku BPC-IoT doske pripojené teplotné čidlo na získanie
teploty okolia.

4.1 Výroba PCB dosky modulu
Z návrhu v programe Altium Designer boli vytvorené potrebné súbory (NC Drill
a Gerber), ktoré sú dostupné v prílohe E pre výrobu dosky modulu. Výroba bola
po odporučení vedúcim práce a predošlých skúsenostiach zadaná firme JLC PCB,
kam boli zaslané podklady pre výrobu modulu. Pre výrobu dosky boli zvolené na-
sledovné základné nastavenia:

Parameter Hodnota Jednotka
Základový materiál FR-4 -
Povrchová úprava HASL (s olovom) -
Farba PCB zelená -
Farba popisu biela -
Rozmery dosky 30 x 51.8 mm
Hrúbka PCB 1 mm
Tolerancia rozmerov ±0,2 mm

Tab. 4.1: Parametre PCB zaslané do výroby

Parametre pre výrobu dosky sa vo veľkej miere zhodujú so základnými paramet-
rami pre výrobu PCB dosky. Jediným rozdielom pri výrobe modulu bolo použitie
tenšej dosky. Zvolená hrúbka je iba 1 mm a to z dôvodu osadenia modulu do slotu
mini PCIe karty, ktorý je pripravený na osadenie modulu práve s týmito rozmermi.
Druhým rozdielom je znížená tolerancia rozmerov, ktorá je potrebná pre presnosť
kontaktov mini PCIe karty a jej slotu.

4.2 Úprava rozmerov dosky modulu
Pri návrhu modulu v prevedení mini PCIe boli použité rozmery pre dosku dostupné
na internete, ktoré boli následne skontrolované odmeraním inej dosky v prevedení
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mini PCIe karty. Aj napriek takejto dvojnásobnej kontrole bola doska, po výrobe
približne o 1 mm väčšia ako bolo možné vložiť do slotu na BPC-IoT doske. Úp-
rava rozmerov bola vykonaná pomocou brúsneho papiera a pravouhlosť vybrúsenej
časti bola zabezpečená pravouhlou sústavou na brúsnej doske. Vybrúsená časť dosky
modulu bola následne ošetrená tekutým lakom na PCB dosky.

Obr. 4.1: Rozmery modulu

4.3 Osadenie dosky modulu súčiastkami
Pre prvú prototypovú verziu modulu bolo zvolené ručné osadenie dosky súčiastkami
v študentskom laboratóriu. Použité rezistory boli z rady E24 - 1% a E12 - 5%. Po osa-
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dení súčiastok bola otestovaná základná funkcionalita dosky - premeranie odporu
a napätia. Vykonaná bola aj kontrola spojenia komunikačných ciest SPI zbernice
medzi kontaktami slotu mini PCIe karty na BPC-IoT doske a SIM konektorom
na doske modulu. Prototyp modulu bol ďalej použitý pre vývoj laboratórnej úlohy
a programové testy.

Obr. 4.2: Osadená doska modulu súčiastkami

4.4 Osadenie BPC-IoT dosky

BPC-IoT doska je doska, na ktorej je osadený mikrokontrolér Raspberry Pi Pico.
V prevedení laboratórnej úlohy je potrebné tento mikrokontrolér naprogramovať
tak, aby pomocou IQRF vysielača bola odoslaná teplota z externého čidla na ko-
ordinátor. Pred samotným programovaním je nutné si ku doske pripojiť všetky vy-
užívané časti obvodu tak, aby bolo možné teplotu získať a odoslať. Na BPC-IoT
dosku pripojíme teplotné čidlo AHT20. Toto čidlo s mikrokontrolérom komunikuje
po zbernici I2C, z čoho jasne vyplýva aj miesto jeho pripojenia ku BPC-IoT do-
ske. Ďalšou nevyhnutnou súčasťou pre odoslanie teploty je IQRF vysielač. Vysielač
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TR-72DA vložíme najskôr do v práci navrhnutého modulu, ktorý následne celý vlo-
žíme do slotu pre mini PCIe kartu. Ako posledné je potrebné na BPC-IoT doske
umiestniť jumper prepojky na správne kontakty na doske. Keďže modul je v preve-
dení mini PCIe karty je nevyhnutné umiestniť jumper prepojku práve na tieto piny.
Druhá prepojka slúžiaca na zvolenie správnej úrovne komunikačnej logiky musí byť
umiestnená do polohy 3,3 V, pretože využívaný IQRF vysielač pracuje práve s touto
logickou napäťovou úrovňou.

BPC-IoT Board

PC
IQRF
modul

AHT20

IQRF
VYSIELAČ

USB C

USB A

I2C

SPI

RF 868MHz

IQRF
KOORDINÁTOR

Obr. 4.3: Bloková schéma zapojenia použitých zariadení

Obr. 4.4: Osadená BPC-IoT doska
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5 Návrh laboratórnej úlohy
Cieľom laboratórnej úlohy je zoznámiť študentov s možnosťami a základnými funk-
ciami technológie IQRF. Technológia IQRF ako taká neobsahuje iba konkrétny hard-
vér (vysielače, gateway či senzory), ale aj ovládací a programovací softvér IQRF IDE.
Laboratórnu úlohu sme rozdelili na dve časti:

• Vytvorenie komunikácie bod - bod
• Vytvorenie mesh siete
• Bonusová úloha

5.1 Základné informácie o vývojovom prostredí IQRF
IDE

Laboratórna úloha bola realizovaná vo vývojovom prostredí IQRF IDE, ktoré je
orientované na vývoj projektov technológie IQRF s grafickým užívateľským prostre-
dím. Pre vývojárov poskytuje komplexnosť, pretože IQRF IDE podporuje dizajno-
vanie, nahrávanie, debugovanie, testovanie a údržbu pre vyvíjané projekty.

Hlavné časti IQRF IDE:
• Debugger a konfiguračný nástroj
• Komunikačný terminál a testovací nástroj
• Správca siete IQMESH (manažment, správa, vizualizácie a testy)
• Servisný nástroj CATS (skener, tester, analyzátor)
• Nástroje na aktualizáciu operačného systému pre vysielače a firmvéru pre USB

zariadenia

5.2 Vytvorenie point to point komunikácie

Prvá časť laboratórnej úlohy je zameraná na precvičenie point to point (bod - bod)
komunikácie, teda spojenia medzi dvoma bodmi (vysielačom a prijímačom, prípadne
obojsmerne medzi dvoma vysielačmi alebo medzi vysielačom/uzlom a koordináto-
rom). V laboratórnej úlohe sme využili nám dostupné zariadenia a bola vytvorená
point to point komunikácia medzi USB koordinátorom (GW-USB-06) a vysielačom
(TR-72DA), kde bol koordinátor nastavený tak, aby sa správal ako jednoduchý prijí-
mač signálu (správ). Na vytvorenie tejto komunikácie bolo potrebné vytvoriť v prog-
rame IQRF IDE projekt a vytvoriť program (TeplotaTX) v jazyku C pre odoslanie
teploty zo vstavaného teplotného čidla. Program pre prijímanie dát bol použitý
z demo cvičenia E02-RX.c.
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Program TeplotaTX.c bolo potrebné nahrať do vysielača pomocou programova-
cieho modulu a program E02-RX.c zase do USB gateway priamo z počítača. Takto
vytvorené a nastavené zariadenia vedia odosielať a prijímať správy po stlačení ap-
likačného tlačidla (na doske označené ako bonding). V terminal logu prostredia
IQRF IDE je možné vidieť prijaté správy viď. obr.5.1 a po rozkliknutí danej správy
je možné vyčítať jej obsah a detail (odosielateľ, veľkosť) viď. obr.5.2. Presný návod
s jednotlivými krokmi sa nachádza v prílohe A.

Obr. 5.1: Terminal log v IQRF IDE

5.3 TeplotaTXIQRF.c

Program v jazyku C využíva funkcie z IQRF OS (knižnica IQRF.h). Program načíta
teplotu z integrovaného teplotného čidla, upraví načítané dáta z čidla, skonvertuje
ich na teplotu a túto teplotu zaokrúhli na potrebný počet desatinných miest. Prog-
ram pripraví text správy, do ktorej je vložená teplota. Táto správa je následne odo-
slaná z IQRF vysielača po stlačení aplikačného tlačidla na module alebo BPC-IoT
doske (BUT0). V programe sú využité funkcie na riadenie SPI zbernice (startSPI,
enableSPI), kopírovanie dát z SPI buffra (bufferCOM) do odosielacieho buffra (buf-
ferRX) a odoslanie správy prostredníctvom IQRF vysielača (RFTXpacket). Zdro-
jový kód tohto programu sa nachádza v prílohe F.

5.4 TeplotaTXRPPico.py

Program v jazyku microPython určený pre riadiacu dosku BPC-IoT, ktorá po stla-
čení tlačidla BUT0 vyšle signál cez SPI zbernicu na IQRF vysielač pre odoslanie
správy s teplotou, ktorá je získavaná interným čidlom na IQRF vysielači. (príloha F)
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Obr. 5.2: Detail prijatej správy

5.5 ExternaTeplotaTXIQRF.c

Program v jazyku C využíva funkcie z IQRF OS (knižnica IQRF.h). Program najskôr
nainicializuje zbernicu SPI. V nekonečnom cykle sa testuje stav zbernice SPI. Ak
nie je zbernica zaneprázdnená, v podmienke sa otestuje či sú na zbernici poslané
nejaké dáta a skontroluje sa CRC suma. V prípade, že zbernica je zaneprázdnená,
bliká LED. Poslané dáta zo zbernice sa prenesú do buffra na odoslanie (bufferRF)
cez vysielač. Následne sa dáta (teplota) odošle cez vysielač na gateway. V prípade,
že na zbernici neboli prijaté žiadne dáta do buffra na odoslanie, je prenesená správa
"no data". Ak sa na zbernici dáta objavili, ale CRC suma nie je korektná, je odoslaná
správa s textom "CRC err". (príloha F)

5.6 ExternaTeplotaTXRPPico.py

Program v jazyku microPython je určený pre riadiacu dosku BPC-IoT board s mik-
rokontrolérom Raspberry Pi Pico. Program načíta teplotu z externe pripojeného
čidla AHT20, pripojeného ku doske cez zbernicu I2C. Poskladá SPI paket podľa
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protokolu na odoslanie a vypočíta CRC sumu, ktorú vloží do SPI paketu. Celý
paket prekonvertujte do poľa bajtov na odoslanie cez funkciu spi.write. Program vy-
užíva knižnice pre komunikáciu po SPI a I2C zberniciach. Taktiež využíva knižnicu
pre komunikáciu s teplotným čidlom AHT20. V prvej časti sa zadefinujú komuni-
kačné a ovládacie piny. Následne sa inicializujú obe zbernice a nastavia sa parametre
prenosu. S využitím zbernice I2C sa nainicializuje teplotné čidlo AHT20. Po ini-
cializácii všetkých potrebných komunikačných ciest sa načíta teplota z čidla. Táto
načítaná teplota sa posiela pre overenie na konzolu. Teplota sa skonvertuje na he-
xadecimálny tvar, obalí sa úvodnými bajtami a CRC podľa protokolu SPI v IQRF.
Celý paket sa tiež vypíše do konzoly na overenie. Pred samotným odoslaním paketu
s teplotou je komunikácia na SPI zbernici zahájená nastavením riadiaceho signálu na
nízku úroveň (logická 0) a po odoslaní dát je táto komunikácia zase ukončená nasta-
vením toho istého signálu na vysokú úroveň (logická 1). Toto opakované odosielanie
teploty je vykonávané neustále pomocou nekonečného cyklu. (príloha F)

5.7 Vytvorenie IQRF mesh siete
Pre vytvorenie siete mesh je potrebné použiť koordinátor a niekoľko podriadených
uzlov, ktoré budú sieť tvoriť a bude u nich fungovať routovanie na pozadí. Na vy-
tvorenie siete sa využíva proces, ktorý sa nazýva bonding alebo jednoduchšie (pá-
rovanie). Aby tento proces fungoval je potrebné sa uistiť, že uzly (vysielače), ktoré
sú v sieti použité, nie sú aktualne spárované s iným koordinátorom. Pre uistenie sa
bolo na začiatok druhej časti laboratórnej úlohy vložené zresetovanie bondovacích
nastavení koordinátora aj uzlov za pomoci IQRF IDE v prípade koordinátora. V prí-
pade uzlov je tento reset vykonaný použitím presnej kombinácie stlačenia tlačidiel
na doske. V programe IQRF IDE bolo potrebné pridať plug-iny pre koordinátor
a podriadené uzly, ktoré boli nahrané do jednotlivých zariadení. Následne bola vy-
tvorená sieť mesh a v nej prebehol algoritmus objavenia a priradenia virtuálnych
smerovacích čísel.

Po vytvorení siete bola navrhnutá krátka úloha o preskúmaní parametrov siete
v programe IQRF IDE.
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Obr. 5.3: Zobrazenie mesh siete v záložke map view v IQRF IDE

5.8 Bonus.py
Do laboratórnej úlohy je pridaná aj bonusová úloha, ktorá simuluje reálnu situáciu
s IoT sveta. Pre vyriešenie tejto úlohy bolo potrebné upraviť program Externa-
TeplotaTXRPPico.py tak, že funkcia čítajúca teplotu z čidla zaokrúhli jej hodnotu
na jedno desatinné miesto. Pre prenos aj záporných teplôt sa použije offset +40.
Takýto postup pre získanie teploty je možné využiť napríklad v našich klimatických
podmienkach, v ktorých teploty v zime nie sú nižšie ako -40 °C a v lete zase nepresa-
hujú 50 °C. Výsledné číslo reprezentujúce teplotu je potrebné ešte vynásobiť číslom
10, aby sa nemusela prenášať desatinná čiarka. Takto upravená teplota pri odosielaní
cez technológiu IQRF posiela výrazne menej dátových bajtov, čím skracuje vysielací
čas a tak šetrí batériu. V laboratórnej úlohe gateway nie je naprogramovaný tak,
aby si z prijatej hodnoty reverzne získal reálnu teplotu, čo však nie je problém na-
programovať pri reálnom prípade zápisu teploty napríklad do grafu na virtuálnom
úložisku cloud.
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Záver
Táto bakalárska práca bola zameraná na vytvorenie laboratórnej úlohy z predmetu
Komunikačné systémy pre IoT, ktorá sa venuje technológii IQRF. Pre potreby labo-
ratórne úlohy bol navrhnutý modul pre spojenie IQRF vysielača a dosky BPC-IoT.
Vďaka tomuto modulu BPC-IoT doska dokáže komunikovať s IQRF vysielačom.

Modul bol navrhnutý tak, aby boli dodržané odporúčania výrobcu pre správne
napájanie IQRF vysielača a pre jeho bezproblémovú komunikáciu s BPC-IoT dos-
kou. Návrh modulu bol realizovaný v programe Altium Designer. Schéma zapojenia
modulu a návrh dosky plošného spoja sú prílohou bakalárskej práce.

Po oboznámení sa s možnosťami IQRF vysielača a BPC-IoT dosky bola pre ko-
munikáciu zvolená zbernica SPI, ktorá je výrazne podporovaná programovými funk-
ciami IQRF zariadení.

Modul bol vytvorený v tvare mini PCIe karty. Toto prevedenie bolo vhodnejšie
hlavne z proporčného hľadiska, pretože v práci použitý IQRF vysielač sa pripája
do obvodu pomocou pomerne rozmerného SIM konektora.

Pre laboratórnu úlohu bol vybraný IQRF vysielač TR-72-DA, ktorý disponuje
integrovanou PCB anténou s dosahom 500 m voľného priestranstva, čo je pre la-
boratórne využitie maximálne postačujúce. Vysielač je taktiež veľmi jednoducho
vyberateľný z obvodu, v ktorom je inštalovaný, vďaka už spomínanému SIM konek-
toru. Tento spôsob pripojenia uľahčuje zmeny programu a nastavení, ktoré sú počas
realizácie laboratórnej úlohy pomerne časté.

Ako koordinátor je použitý USB gateway technológie IQRF GW-USB-06, ktorý
je, rovnako ako zvolený vysielač, najvhodnejšou variantou pre laboratórne využitie,
pretože je pripojiteľný priamo cez USB konektor k počítaču, v ktorom je zobrazovaná
prijatá správa.

Laboratórna úloha bola navrhnutá tak, aby študentov zoznámila s IQRF techno-
lógiou a jej možnosťami v sieti mesh. Počas vypracovania úlohy sa študenti obozná-
mia aj s vývojovým prostredím IQRF IDE, ktoré je využívané pre programovanie
a správu IQRF zariadení. Taktiež sa zoznámia s možnosťou poskytovania dát pre vy-
sielač prostredníctvom zbernice SPI, ktorá je jednou z podporovaných zberníc IQRF
zariadeniami. Spracované dáta IQRF vysielačom sú následne posielané v jednodu-
chej sieti na koordinátor, ktorý ich premietne do počítača prostredníctvom IQRF
IDE.

Súčasťou bakalárskej práce sú programy pre IQRF zariadenia v jazyku C a tak-
tiež programy pre BPC-IoT dosku s využitím programovacieho jazyka microPython,
ktoré sú použité v laboratórnej úlohe.

Laboratórna úloha je preložená aj do anglického jazyka pre potreby výučby za-
hraničných študentov.
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Zoznam symbolov a skratiek
ACK Acklowledgement

A/D Analog / Digital

AES Advanced Encryption Standard

BLE Bluetooth Low Energy

C Koordinátor

CLK Clock

CRC Cyclic Redundancy Check

CSMA-CA Carrsie Sence Multiple Access Collision Avoidence

DC Direct Curent

DSSS Direct Sequence Spread Spektrum

FEC Forward Error Correction

FSK Frequency Shift Keying

GND Ground

IC Integrated Circuit

IDE Integrated Desktom Enviroment

IEEE Institute of Electrical and Electronics Engineers

IO Input Output

IoT Internet of Things - Internet vecí

IQRF Inteligent Quick Response Frequency

ISM Industrial Scientific Medical

LDO Low Dropout Output

LP Low Power

MCU MIcrocontroler Unit

MISO Main In Slave Out
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MOSI Main Out Slave In

N Node

OQPSK Offset Qadrante Phase shift Keying

OS Operačný systém

OTA Ower The Ai

PCB Printed Circuit Board

PWM Pulse Width Modulation

RF Radio Frequency

RFPGM Radio Frequency Programming

RTCC Real Time Clock Calendar

RX Receive

RXD Receive Data

SCL Synchronous CLock

SCLK Slave Clock

SDA Serial Data

SPI Serial Pheripheral Interface

SS Slave Select

STD Standard

TX Transmit

TXD Transceive Data

UART Universal Asynchronous Reciever-Transmitter

VIN Voltage IN

VOUT Voltage OUT

WLAN Wireless Local Area Network

WMAN Wireless Metropolitan Area Network
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WPAN Wireless Personal Area Network

WSN Wireless Sensor Network

WWAN Wireless Wide Area Network

XLP Extra Low Power
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A Laboratórna úloha IQRF mesh siete

A.1 Cieľ merania
Cieľom laboratórnej úlohy je zoznámiť študentov so základnými funkciami a mož-
nosťami IoT technológie IQRF, pochopiť topológiu mesh a princípy komunikácie
medzi zariadeniami v nej.

A.2 Zadanie
• Zoznámte sa so zariadeniami na pracovisku.
• Vytvorte jednoduchú Point to Point komunikáciu medzi koordinátorom a vy-

sielačom. V tejto jednoduchej sieti naprogramujete dostupný mikrokontrolér
Raspberry Pi Pico tak, aby prenášal informácie o teplote z uzla na koordinátor.

• Vytvorte sieť s topológiou mesh obsahujúcu koordinátor a dva uzly a zoznámte
sa s vplyvom zmeny polohy uzla na signál a topológiu mesh siete.

A.3 Teoretický úvod
IQRF (Intelligent Quick Response Frequency) je bezdrôtová technológia a platforma
pre IoT orientovaná paketovo. Umožňuje posielať nízke množstvo dát s minimálnou
spotrebou elektrickej energie a maximálnou spoľahlivosťou. Technológia je vhodná
pre náročné aplikácie, ktoré si vyžadujú čo najnižšiu spotrebu elektrickej energie ako
sú batériou napájané inštalácie, aplikácie pre IoT, smart mestá či budovy.

IQRF technológia pracuje v nelicencovanom Sub-GHz ISM (industrial scientific
medical) rádiovom pásme (433, 868, 915 MHz) v závislosti od kontinentu alebo
štátu inštalácie. V Českej republike je používané 868 MHz pásmo. Moduly IQRF
technológie môžu pracovať v rôznych topológiách ako napr. bod – bod, hviezda,
ale najčastejšie je používaná v mesh topológii. Na obr.A.1 je znázornený typický
dizajn IQRF siete obsahujúci jednotlivé uzly (senzory) v mesh topológii, gateway,
cloud a pripojenie na internet (aplikácia pre komunikáciu so svetom).
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`` APLIKÁCIAGATEWAY CLOUD

IQRF MESH SIEŤ

Senzory
(uzly)

Vysielač 

Obr. A.1: Štruktúra IQRF siete

Maximálny dosah jedného IQRF vysielača je certifikovaný na 500 m voľného prie-
stranstva, čo pri použití viac ako 200 zariadení v mesh topológii predstavuje rozlohu
až desiatky kilometrov štvorcových. Z toho dôvodu IQRF sieť radíme do kategórie
WMAN (Wireless Metropolitan Area Network). Na obr. B.2 je dosah IQRF siete
porovnaný s dosahmi iných IoT sietí.

IQMESH (Inteligent Mesh) je patentovaný meshový komunikačný protokol po-
užívaný vrámci ekosystému technológie IQRF. Je navrhnutý na sprostredkovanie
bezdrôtovej komunikácie v mesh topológii, kde každé zariadenie môže komuniko-
vať s okolitými zariadeniami a potenciálne slúžiť ako preposielací uzol na rozšírenie
dosahu siete. Každý paket je smerovaný uzlami na pozadí neobmedzujúc ich funkcio-
nalitu. Tento proces je riadený operačným systémom a je nebadateľný pre užívateľa.
IQMESH podporuje viaceré smerovacie štruktúry ako sú: úplný mesh, redukovaný
mesh, optimalizovaný mesh, strom... Smerovanie môže prebiehať staticky, a taktiež
môže byť pod úplnou kontrolou užívateľa. Dynamické časovanie s výberom počtu
krokov v sieti a voliteľným časovým úsekom umožňuje maximálnu priepustnosť s mi-
nimálnym rušením a spotrebou elektrickej energie. Efektivita a spoľahlivosť je do-
siahnutá pomocou takzvaného záplavového mechanizmu, ktorý funguje podobne ako
povodeň - informácia je na miesto doručenia poslaná viacerými možnými cestami
- podobne ako voda pri povodni zaplavuje miesta kadiaľ môže pretiecť. Kolíziám
v sieti sa predchádza pomocou systému Time Division Multiple Access, čo v pre-
klade znamená viacnásobný prístup s časovým delením.

Ostatné technické parametre siete sú v tabuľke tab B.1
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WPAN

Wi-Fi, Bluetooth, ZigBee

10 - 100 m

WLAN

Wireless M-Bus, Wi-Fi

100 - 1000 m

WNAN

IQRF

WWAN

1 - 10 km

LoRa, SigFox

10 - 100 km

Obr. A.2: Porovnanie dosahu viacerých sietí z IoT odvetvia

IQRF
Veličina Jednotka Hodnota

Pracovná frekvencia MHz 433, 868, 916
Prenosová rýchlosť kbps 20
Max. dĺžka prenášanej správy byte 64
Max. dosah vo voľnom priestranstve m 1000
Modulácia - GFSK
Topológia - mesh
Oneskorenie ms 60 - 100
Max. počet uzlov na gateway - 65*103
Teoretický čas života na AAA batérii rok 5 - 10

Tab. A.1: Prehľad parametrov IQRF siete

A.4 Postup pre vypracovanie merania
Najskôr si skontrolujeme zapojenie pracoviska podľa blokovej schémy B.3 a skon-
trolujeme polohu jumper prepojok prvá v polohe pre logiku 3,3 V, druhá v mieste
povoľujúcom mini PCIe kartu.
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BPC-IoT Board

PC
IQRF
modul

AHT20

IQRF
VYSIELAČ

USB C

USB A

I2C

SPI

RF 868MHz

IQRF
KOORDINÁTOR

Obr. A.3: Bloková schéma zapojenia pracoviska

A.4.1 Point to point komunikácia

Pred vytvorením point to point komunikácie je potrebné vytvoriť a nahrať do BPC-
IoT dosky program, ktorý je v jazyku microPython. Tento program prijme teplotu
z teplotného senzora po zbernici I2C spracuje ju a podľa IQRF SPI guide a vytvorí
paket, ktorý je prijatý IQRF vysielačom.

Spustíte program IQRF IDE a vytvorte si nový projekt: New -> Non-networking
Demo -> Next. Projekt pomenujte a stlačte Next. TR Module nastavte na TR-
72Dx a IQRF OS ponechajte na najnovšej verzii: Finish -> Yes to All. Do no-
vovytvoreného projektu pridajte demo časti kódu - v ľavej časti obrazovky v zá-
ložke Project kliknite pravým tlačidlom myši na Source -> Add -> Existing
Item...-> ExternaTeplotaTXIQRF.c -> Open a prijímaciu časť pravým tla-
čidlom myši kliknite na Source -> Add -> New Non-networking Example....
V novootvorenom okne vyberte E02-example of simple RF receiving. Vyberte
a potvrďte demo kód. -> Next -> Finish -> Yes -> Yes to All. V záložke
Source by sa mali nachádzať časti kódu (ExternaTeplotaTXIQRF.c a E02-RX.c),
ak nie, zopakujte postup.

Keď máme vytvorené demo projekty, musíme si vytvoriť výstupné HEX súbory,
ktoré sa dajú nahrať do jednotlivých zariadení. Označte si krúžkom prvý projekt
ExternaTeplotaTXIQRF.c a stlačte zelenú kocku (B.4 - 1) v hornej časti obra-
zovky. V záložke Output HEX (záložka pod Source) sa objaví vytvorený Hex File
s názvom podľa zdroja (TeplotaTX.hex). Rovnako vytvorte HEX file aj pre druhú
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časť E02-RX.c (E02-RX.hex).

Pre správnu funkciu siete (aj Point to Point) je potrebné, aby boli obe zariadenia
nastavené na rovnaké frekvenčné pásmo. Preto dvojklikom otvorte záložku TR con-
figuration a RF band nastavte na 868 MHz, RF channel A na 67 a RF channel B
na 62. Tlačidlom Close -> Yes -> Save potvrďte vašu konfiguráciu. Táto kon-
figurácia sa objaví v záložke TR configuration na ľavej strane obrazovky.
Takto vytvorené výstupné HEX súbory a TR konfiguráciu vieme nahrať do jed-
notlivých zariadení. Pripojte do počítača USB koordinátor a v ľavom dolnom rohu
obrazovky sa zobrazí blikajúci zelený krúžok s pomenovaním pripojeného zariadenia
GW-USB-06. Ak to tak nie je, je potrebné skontrolovať, či nie je otvorené IQRF
IDE vo viacerých oknách alebo odpojiť a znova zapojiť programované zariadenie.
Ak už bliká zelený krúžok, všetko je pripravené na nahratie programu. Do koor-
dinátora nahrávame prijímaciu časť projektu, preto si označte v záložke Output
HEX E02-RX.hex a v záložke TR configuration si označte vami vytvorenú konfigu-
ráciu. Následne stlačte tlačidlo mikrokontroléra s modrou fajkou (B.4 - 2)
v hornej časti obrazovky. V dolnej časti obrazovky sa objaví potvrdzujúca hláška
o úspešnom nahratí programu do GW-USB-06. Pre nahratie vysielacej časti prog-
ramu najskôr zasuňte červený vysielač do SIM slotu na programátore (modul so sivou
podstavou) a pripojte ho pomocou USB kábla do počítača. Následne v dolnej časti
obrazovky kliknite pravým tlačidlom myši na zelený blikajúci krúžok a zvoľte si
druhé zariadenie (CK-USB -04A). V záložke Output HEX vyberte TeplotaTX.hex
tlačidlom mikrokontroléra s modrou fajkou (B.4 - 2) nahrajte program aj
do druhého zariadenia. Opätovne sa objaví potvrdzujúca správa v dolnej časti obra-
zovky. Naprogramovaný vysielač vložte naspäť do BPC-IoT board. Tento program
prijme teplotu a po zbernici SPI a skontroluje jej správnosť a odošle ju na IQRF
koordinátor. Správnosť prijatia správy skontrolujte v časti Terminal Log, ktorá sa
nachádza v dolnej časti obrazovky.

1 2

Obr. A.4: IQRF IDE pre lepšiu navigáciu
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A.4.2 IQRF mesh sieť

Pre vytvorenie novej mesh siete je potrebné sa najskôr uistiť, že použité prvky siete
(koordinátor a uzly) nie sú už spárované s inými prvkami. Preto vykonáme reset
párovacích nastavení najskôr pre koordinátor potom pre uzly.

Začneme pridaním Plug-inov do projektu, ktoré bude potrebné nahrať do ko-
ordinátora a do uzlov. Pravým tlačidlo myši klikneme na záložku Project ->
Plug-ins -> Add -> DPA Plug-in... v novootvorenom okne zaškrtneme DPA-
Coordinator-SPI-7xD... a DPA-Node-STD-7xD... a potvrdíme výber tlačidlom OK.
Pri nahrávaní do jednotlivých zariadení je potrebné, aby boli zaškrtnuté iba záložky
Plug-ins s konkrétnou časťou pre koordinátor alebo pre uzol a v záložke TR Con-
figuration konfigurácia z predošlého cvičenia. Rovnakým spôsobom ako v predošlej
časti nahráme Plug-in aj konfiguráciu do koordinátora a do uzlov. V tomto prípade
už nie je potrebné vytvárať HEX súbory.

Ak máme úspešne naprogramovaný koordinátor aj uzol, môžeme začať s reseto-
vaním predošlých informácií o párovaní. Pre resetovanie koordinátora je potrebné
najskôr koordinátor pripojiť k počítaču. Následne zvolíme záložku IQMESH Ne-
twork Manager v dolnej časti obrazovky a v nej zase vyberieme záložku Control
a v časti Bonding zvolíme Clear All Bonds.

Ako ďalšie musíme resetovať uzly (vysielače). Uzly budeme resetovať pomocou
kombinácie tlačidiel na doske. Stlačíme tlačidlo SW1 a držíme stlačené, počas toho
krátko stlačíme tlačidlo SW2. Začne svietiť zelená LEDka. Okamžite po jej zhasnutí
pustíme tlačidlo SW1. Po tomto úkone by mal vysielač začať blikať na červeno
približne na 10 sekúnd, potom sa uspí.

Pre nabondovanie vysielačov ku koordinátoru sa vrátime do IQRF IDE a na zá-
ložke Control v časti Bonding označíme Auto address a stlačíme Bond Node.
Po stlačení sa objaví okno s načítavaním, v tej chvíli máme 10 sekúnd na to, aby sme
stlačili SW2 na doske s vysielačom. Po úspešnom nabondovaní uzla ku koordinátoru
okno s načítavaním zmizne a v tabuľke uzlov sa objaví oranžová bodka. Tento proces
resetovania a nabondovania zopakujeme pre všetky uzly. Ak máme nabondovaných
už viacero uzlov, prepneme sa do záložky Map View a v hornej časti obnovíme
zobrazenie. Ak je všetko správne, môžeme vidieť schému koordinátora a ku nemu
nabondovaných uzlov.

Táto schéma síce obsahuje koordinátor a uzly avšak neobsahuje zatiaľ cesty a spo-
jenia medzi jednotlivými bodmi siete, preto je potrebné spustiť proces s názvom dis-
covery, ktorý priradí jednotlivé uzly do zón a pridelí im virtuálne smerovacie čísla.
Pre simuláciu reálneho stavu umiestnime niektoré uzly do vzdialenejšej polohy alebo
môžeme použiť tieniaci obal. Na záložke Control v sekcii bonding znížime TX po-
wer na 1, taktiež z dôvodu zhoršenia parametrov siete. Teraz spustíme vyhľadávací
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algoritmus tlačidlom Discovery. Následne sa v karte Map View po aktualizovaní
zobrazia aj cesty medzi uzlami a vytvoria sa takzvané zóny, ktoré znázorňujú logické
usporiadanie siete z pohľadu koordinátora. Správnosť vykonania akcie discovery mô-
žeme taktiež overiť tak, že v záložke Control zmodrejú bodky znázorňujúce jednotlivé
uzly viď. B.5

V záložke Table View sa teraz nachádza tabuľka s jednotlivými bodmi našej
siete, s jej parametrami ako je napríklad RSSI (Receive Signal Strenght Indication)
udávajúci silu prijatého signálu. Pre názornú ukážku funkčnosti mesh siete teraz
umiestnime vysielače do rôznej vzdialenosti a znova vykonáme proces discovery.
V karte Map View je teraz dostupná nová topológia IQRF mesh siete. Funkčnosť
komunikácie medzi vysielačom a uzlami overíme tak, že zašleme na jednotlivé vy-
sielače správy, ktoré vykonajú nami zvolenú akciu (vypni-zapni LED). Pravým tla-
čidlom klikneme na riadok s daným vysielačom a v menu zvolíme LED on. Táto
správa sa prenesie sieťou a na určenom vysielači rozsvieti LED.

Obr. A.5: Sekcia Nodes info
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A.4.3 Bonusová úloha

Upravte program ExternaTeplotaTXRPPico.py tak, aby bolo možné posielať tep-
loty pod nulou s presnosťou na jedno desatinné miesto. Zároveň teplotu upravte tak,
aby sa ušetrilo čo najviac prenášaných dát.

Nápoveda: pre odosielanie teploty použite 3 bajty a offset teploty.

Takto upravená správa je v technológiách IoT častejšie využívaná, pretože šetrí po-
čet vysielaných bajtov, čo má za následok skrátenie času potrebného pre odoslanie.
Ak vysielač vysiela kratšie, tak dochádza ku výraznej úspore spotrebovanej energie,
čo je veľmi dôležitý faktor pre zariadenia napájané z batérie.

A.4.4 Použité prvky na pracovisku

• PC s IQRF ID a progamom Thonny
• BPC - IoT - doska
• Teplotné čidlo AHT20
• Koordinátor GW-USB-06
• Vysielač IQRF TR-72DA 3ks
• Programovacia doska CK-USB-04a
• Aplikačná doska DK-EVAL-04a 2ks
• Prepojovacie káble USB A do USB C a USB A do mikroUSB
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B Laboratory task IQRF module for measu-
ring of mesh networks

B.1 Measurement Objective
The objective of the laboratory task is to familiarize students with the basic functions
and possibilities of IQRF IoT technology, understand the mesh topology and the prin-
ciples of communication between devices within it.

B.2 Assignment
• Familiarize yourself with the devices in the workplace.
• Create a simple Point to Point communication between the coordinator and

the transmitter. In this simple network, program the available Raspberry Pi
Pico microcontroller to transmit temperature information from the node to
the coordinator.

• Create a network with a mesh topology containing a coordinator and two no-
des, and familiarize yourself with the impact of changing the position of a node
on the transmitting signal and the mesh network topology.

B.3 Theoretical Introduction
IQRF (Intelligent Quick Response Frequency) is a wireless technology and plat-
form for IoT that is packet-oriented. It allows the transmission of small amounts
of data with minimal power consumption and maximum reliability. The technology
is suitable for demanding applications that require the lowest possible power con-
sumption, such as battery-powered installations, IoT applications, smart cities and
buildings.

IQRF technology operates in the unlicensed Sub-GHz ISM (industrial scientific
medical) radio bands (433, 868, 915 MHz), depending on the continent or country
of installation. In the Czech Republic, the 868 MHz band is used. IQRF technology
modules can operate in various topologies, such as point-to-point, star, but most
commonly, it is used in mesh topology. Figure B.1 shows a typical design of an IQRF
network containing individual nodes (sensors) in a mesh topology, a gateway, cloud,
and an internet connection (application for communication with the outside world).
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Obr. B.1: Structure of IQRF network

The maximum range of a single IQRF transmitter is certified at 500 m in open
space, which when using more than 200 devices in a mesh topology, can cover an area
of up to tens of square kilometers. For this reason, the IQRF network is classified as
a WMAN (Wireless Metropolitan Area Network). Figure B.2 compares the range of
an IQRF network with the ranges of other IoT networks.

IQMESH (Intelligent Mesh) is a patented mesh communication protocol used
within the IQRF technology ecosystem. It is designed to facilitate wireless commu-
nication in a mesh topology, where each device can communicate with surrounding
devices and potentially serve as a relay node to extend the network’s range. Each
packet is routed through the nodes without restricting their functionality. This pro-
cess is managed by the operating system and is transparent to the user. IQMESH
supports various routing structures such as full mesh, reduced mesh, optimized mesh,
tree, etc. Routing can be static and can also be under the complete control of the
user. Dynamic timing with a selection of the number of hops in the network and an
optional time slot allows for maximum throughput with minimal interference and
power consumption. Efficiency and reliability are achieved through a so-called flo-
oding mechanism, which works similarly to a flood - the information is sent to the
destination through multiple possible paths, similar to how water in a flood inunda-
tes areas it can flow through. Collisions in the network are prevented using a Time
Division Multiple Access system, which means multiple access with time division.
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WPAN

Wi-Fi, Bluetooth, ZigBee

10 - 100 m

WLAN

Wireless M-Bus, Wi-Fi

100 - 1000 m

WNAN

IQRF

WWAN

1 - 10 km

LoRa, SigFox

10 - 100 km

Obr. B.2: Comparison of the range of various networks in the IoT sector

Other technical details of IQRF network are in table Tab. B.1

IQRF
Parameter Unit Value

Operating frequency MHz 433, 868, 916
Data rate kbps 20
Max. message lenght byte 64
Max. range in open space m 1000
Modulation - GFSK
Topology - mesh
Latency ms 60 - 100
Max. numberof nodes per gateway - 65*103
Theoretical lifetime on AAA battery year 5 - 10

Tab. B.1: Summary of IQRF network parameters

B.4 Procedure for Measurement
First, check the setup of the workstation according to the block diagram in Figure
B.3 and verify the position of the jumpers. The first should be set for 3.3 V logic,
and the second should enable the mini PCIe card.
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BPC-IoT Board

PC
IQRF

module

AHT20

IQRF
TRANSCIEVER

USB C

USB A

I2C

SPI

RF 868 MHz

IQRF
COORDINATOR

Obr. B.3: Block diagram of the workstation setup

B.4.1 Point to point Communication

Before creating point-to-point communication, it is necessary to create and upload
a program in microPython language to the BPC-IoT board. This program will re-
ceive the temperature from the temperature sensor via the I2C bus, process it, and
according to the IQRF SPI guide, create a packet that is received by the IQRF
transmitter.

Launch the IQRF IDE program and create a new project: New -> Non-
networking Demo -> Next. Name the project and click Next. Set the TR
Module to TR-72Dx and keep the IQRF OS on the latest version: Finish -> Yes
to All. Add demo code parts to the newly created project - right-click on the Pro-
ject tab on the left side of the screen and select Source -> Add -> Existing
Item...-> ExternaTeplotaTXIQRF.c -> Open for the transmission part, and
for the reception part, right-click Source -> Add -> New Non-networking
Example.... In the newly opened window, select E02-example of simple RF
receiving. Choose and confirm the demo code. -> Next -> Finish -> Yes ->
Yes to All. The Source tab should now contain the code parts (ExternaTeplotaT-
XIQRF.c and E02-RX.c); if not, repeat the procedure.

Once the demo projects are created, we need to generate output HEX files that
can be uploaded to the individual devices. Highlight the first project ExternaTeplo-
taTXIQRF.c with a circle and press the green cube (B.4 - 1) at the top of the
screen. The Output HEX tab (below Source) will show the created Hex File named
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after the source (TeplotaTX.hex). Similarly, create a HEX file for the second part
E02-RX.c (E02-RX.hex).

For proper network function (even Point to Point), both devices must be set to
the same frequency band. Therefore, double-click the TR configuration tab and
set the RF band to 868 MHz, RF channel A to 67, and RF channel B to 62. Confirm
your configuration with the Close -> Yes -> Save button. This configuration
will appear in the TR configuration tab on the left side of the screen.

The created output HEX files and TR configuration can be uploaded to the
individual devices. Connect the USB coordinator to the computer, and a flashing
green circle labeled GW-USB-06 will appear in the lower left corner of the screen. If
not, check if IQRF IDE is open in multiple windows or reconnect the programmed
device. Once the green circle is flashing, everything is ready to upload the program.
Upload the receiving part of the project to the coordinator by selecting E02-RX.hex
in the Output HEX tab and your created configuration in the TR configuration tab.
Then press the microcontroller button with a blue checkmark (B.4 - 2) at
the top of the screen. A confirmation message about the successful program upload
to GW-USB-06 will appear at the bottom of the screen

To upload the transmission part of the program, first insert the red transmitter
into the SIM slot on the programmer (module with gray base) and connect it to
the computer using a USB cable. Then, in the lower part of the screen, right-click
on the flashing green circle and select the second device (CK-USB -04A). In the
Output HEX tab, select TeplotaTX.hex and upload the program to the second device
using the microcontroller button with a blue checkmark (B.4 - 2). Another
confirmation message will appear at the bottom of the screen. Insert the programmed
transmitter back into the BPC-IoT board. This program receives the temperature
via the SPI bus, checks its correctness, and sends it to the IQRF coordinator. Verify
the correctness of the received message in the Terminal Log section at the bottom
of the screen.

1 2

Obr. B.4: IQRF IDE for better navigation
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B.4.2 IQRF Mesh Network

To create a new mesh network, you first need to ensure that the network elements
(coordinator and nodes) are not already paired with other elements. Therefore, reset
the pairing settings for the coordinator first, then for the nodes.

We start by adding Plugins to the project, which will need to be uploaded to
the coordinator and the nodes. Right-click on the Project -> Plug-ins -> Add
-> DPA Plug-in... tab, in the newly opened window, check DPA-Coordinator-
SPI-7xD... and DPA-Node-STD-7xD..., and confirm the selection by clicking OK.
When uploading to individual devices, ensure that only the Plugin tabs specific
to the coordinator or node are checked, and in the TR Configuration tab, use the
configuration from the previous exercise. In the same way as in the previous part,
upload both the Plugin and the configuration to the coordinator and the nodes. In
this case, it is not necessary to create HEX files.

Once the coordinator and node are successfully programmed, you can begin
resetting previous pairing information. To reset the coordinator, connect it to the
computer first. Then select the IQMESH Network Manager tab at the bottom
of the screen, select the Control tab in it, and in the Bonding section, choose Clear
All Bonds.

Next, we need to reset the nodes (transmitters). The nodes will be reset using
a combination of buttons on the board. Press and hold the SW1 button, then briefly
press the SW2 button while still holding SW1. The green LED will light up. Release
SW1 immediately after the green LED turns off. After this operation, the transmitter
should start flashing red for about 10 seconds before going to sleep.

To bond the transmitters to the coordinator, return to IQRF IDE and, in the
Control tab, in the Bonding section, check Auto address and press Bond Node.
After pressing, a loading window will appear; at this moment, you have 10 seconds
to press SW2 on the transmitter board. Upon successful bonding of the node to the
coordinator, the loading window will disappear, and an orange dot will appear in the
node table. Repeat this process of resetting and bonding for all nodes. If multiple
nodes are bonded, switch to the Map View tab and refresh the view at the top.
If everything is correct, you will see a diagram of the coordinator and the bonded
nodes.

This diagram contains the coordinator and nodes but does not yet show the paths
and connections between the network points, so it is necessary to run a process call-
ed discovery. This process assigns the nodes to zones and gives them virtual routing
numbers. To simulate a real situation, place some nodes in distant locations or use
a shielding cover. In the Control tab, under bonding, reduce the TX power to 1 to
worsen the network parameters. Now run the discovery algorithm by clicking Dis-
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covery. Subsequently, in the Map View tab, after updating, paths between nodes
will be displayed, creating so-called zones that represent the logical arrangement of
the network from the coordinator’s perspective. The success of the discovery action
can also be verified by the blue dots representing the individual nodes turning blue
in the Control tab, see B.5.

In the Table View tab, a table now contains the individual points of our net-
work with their parameters, such as RSSI (Receive Signal Strength Indication),
indicating the strength of the received signal. For a practical demonstration of the
mesh network’s functionality, place the transmitters at various distances and perform
the discovery process again. In the Map View tab, the new topology of the IQRF
mesh network is now available. The functionality of communication between the
transmitter and nodes can be verified by sending messages to the transmitters to
perform a chosen action (turn on/off LED). Right-click on the row with the given
transmitter and select LED on from the menu. This message will be transmitted
through the network, and the LED on the specified transmitter will light up.

Obr. B.5: Section Nodes info
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B.4.3 Bonus Task

Modify the program ExternaTeplotaTXRPPico.py so that it can send temperatures
below zero with an accuracy of one decimal place. Additionally, adjust the tempe-
rature transmission to save as much data as possible.

Hint: use 3 bytes and an offset for temperature transmission.

The modified message is more commonly used in IoT technologies because it sa-
ves the number of transmitted bytes, resulting in shorter transmission times. When
the transmitter sends for a shorter duration, it leads to significant energy savings,
which is a crucial factor for battery-powered devices.

B.4.4 Components used in the workstation

• PC with IQRF IDE and Thonny program
• BPC-IoT board
• Temperature sensor AHT20
• Coordinator GW-USB-06
• IQRF TR-72DA transmitter (3 pieces)
• Programming board CK-USB-04a
• Application board DK-EVAL-04a (2 pieces)
• USB A to USB C cables and USB A to microUSB cables
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D 3D model dosky modulu
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E Gerber data
Jednotlivé gerber súbory pre výrobu modulu, ktoré sú potrebné pri zadávaní objed-
návky u výrobcu.

Obr. E.1: Top layer
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Obr. E.2: Bottom layer

Obr. E.3: Top Solder

100



Obr. E.4: Bottom Solder

Obr. E.5: Top Overlay
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Obr. E.6: Top Paste

Obr. E.7: Bottom Paste
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F Zdrojové kódy

1 import time
2 import struct
3 from machine import SPI , Pin , I2C
4 from ahtx0 import AHT20
5

6 # Initialization of SPI bus
7 sck_pin = Pin (10, Pin.OUT)
8 mosi_pin = Pin (11, Pin.OUT)
9 miso_pin = Pin (12, Pin.IN)

10 cs_pin = Pin (13, Pin.OUT)
11

12 spi = SPI (1, baudrate =20000 , polarity =0, phase =0, sck=sck_pin , mosi
=mosi_pin , miso= miso_pin )

13 cs_pin .value (1)
14

15 # Initialization of I2C bus
16 i2c1 = I2C (1, scl=Pin (15) , sda=Pin (14) , freq =100000)
17

18 # Initialization of temperature sensor
19 tmp_sensor = AHT20(i2c1)
20 tmp_sensor . initialize ()
21

22 # Function to read temperature from sensor
23 def ReadTemp ():
24 time. sleep (0.5)
25 temp = tmp_sensor . temperature
26 print(str(round(temp , 2)))
27 time. sleep (1)
28 return "{:.2f}". format (round(temp , 2))
29

30 # Function to calculate CRC
31 def calculate_crc ( hex_string ):
32 xor_result = 0xF0 ^ 0x85 ^ 0x5F # Initialize XOR
33 for i in range (0, len( hex_string ), 2):
34 xor_result ^= int( hex_string [i:i+2], 16)
35 return xor_result
36

37 # Function to create SPI packet and send it
38 def SendTemp (temp):
39 hex_string = ’’.join(’{:02x}’. format (ord(c)) for c in temp)
40 crc_value = calculate_crc ( hex_string )
41 message = f’f085{ hex_string }{ crc_value :02x}00 ’
42 byte_array = bytes. fromhex ( message )
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43 formatted_string = ’’.join(’\\x{:02x}’. format (b) for b in
byte_array )

44 print(f" Formatted SPI Message : { formatted_string }")
45 spi.write( byte_array )
46

47 while True:
48 temp = ReadTemp ()
49 cs_pin .off () # Start of SPI communication
50 time. sleep_ms (10)
51

52 SendTemp (temp)
53 time. sleep_ms (10)
54

55 print(spi.read (20)) # Reading of slave answer
56 time. sleep_ms (10)
57

58 cs_pin .on() # End of SPI communication

Výpis F.1: Kód pre BPC-IoT dosku odosielajúcu teplotu cez SPI zbernicu na IQRF
vysielač (ExternaTeplotaTXRPPico.py)
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1 # include "IQRF.h"
2 void _sleepWOC (void);
3 void APPLICATION ()
4 {
5 enableSPI ();
6 clrwdt ();
7 // infinite loop of receiving message via SPI
8 while (1)
9 {

10 clrwdt ();
11 sleepWOC ();
12 // LED flashing if SPI bus is busy
13 if ( getStatusSPI ())
14 {
15 pulseLEDR ();
16 }
17 else
18 {
19 if( _SPIRX ) // checking if there are available data
20 {
21 if( _SPICRCok ) // checking if data aren ’t damaged
22 {
23 // data 5 bytes are in bufferCOM
24 copyBufferCOM2RF ();
25 DLEN = SPIpacketLength ;
26 RFTXpacket (); // send message
27 waitDelay (25);
28 startSPI (0); // SPI released for master
29 }
30 else
31 {
32 // damaged data
33 bufferCOM [0] = ’C’;
34 bufferCOM [1] = ’R’;
35 bufferCOM [2] = ’C’;
36 bufferCOM [3] = ’ ’;
37 bufferCOM [4] = ’e’;
38 bufferCOM [5] = ’r’;
39 bufferCOM [6] = ’r’;
40 copyBufferCOM2RF ();
41 DLEN = 7;
42 RFTXpacket (); // send message
43 waitDelay (25);
44 startSPI (0); // SPI released for master
45 waitDelay (250);
46 }
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47 }
48 else
49 { // no data message
50 bufferCOM [0] = ’n’;
51 bufferCOM [1] = ’o’;
52 bufferCOM [2] = ’ ’;
53 bufferCOM [3] = ’d’;
54 bufferCOM [4] = ’a’;
55 bufferCOM [5] = ’t’;
56 bufferCOM [6] = ’a’;
57 copyBufferCOM2RF ();
58 DLEN = 7;
59 RFTXpacket (); // send message
60 waitDelay (25);
61 startSPI (0); // SPI released for master again
62 waitDelay (250);
63 }
64 }
65 }
66 }

Výpis F.2: Kod pre vysielač prijímajúci dáta cez SPI zbernicu a posielajúci ich
koordinátoru (ExternaTeplotaTXIQRF.c)
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1 import time
2 from machine import SPI
3

4 BUT0 = machine .Pin (6, machine .Pin.IN)
5 sck_pin = machine .Pin (10, machine .Pin.OUT)
6 mosi_pin = machine .Pin (11, machine .Pin.OUT)
7 miso_pin = machine .Pin (12, machine .Pin.IN)
8 cs_pin = machine .Pin (13, machine .Pin.OUT)
9

10 spi = SPI (1, baudrate =200000 , polarity =0, phase =0, sck=sck_pin ,
mosi=mosi_pin , miso= miso_pin )

11

12 while True:
13 BUT0_state = BUT0.value ()
14 BUT0_pressed = not BUT0_state
15 print(f" Button Pin State: { BUT0_state } Button Pressed : {

BUT0_pressed }")
16

17 if BUT0_pressed :
18 cs_pin .off ()
19 time.sleep (0.05)
20 cs_pin .on()

Výpis F.3: Kód pre BPC-IoT dosku, ktorý odošle správu o teplote z interného čidla
na IQRF vysiealči stlačením tlačidla BUT0 (TeplotaTXRPPico.py)
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1 # include "IQRF.h"
2 void _sleepWOC (void);
3 void APPLICATION ()
4 {
5 uns16 temperature , tmp;
6 uns8 i, tenths ;
7

8 waitMS (100);
9 enableSPI ();

10

11 while (1)
12 {
13 if ( getTemperature () != -128)
14 { // sending of temperature
15 temperature = param3 ;
16 bufferCOM [0] = ’T’;
17 bufferCOM [1] = ’=’;
18 bufferCOM [2] = ’ ’;
19 bufferCOM [5] = ’.’;
20 bufferCOM [7] = 0xB0;
21 bufferCOM [8] = ’C’;
22

23 if ( temperature .high8 & 0x08)
24 {
25 temperature = ~ temperature ;
26 temperature ++;
27 bufferCOM [2] = ’-’;
28 }
29 // makiing decimal part
30 tenths = temperature .low8 & 0x0F;
31 temperature >>= 4;
32 i = temperature .low8 / 10;
33 bufferCOM [3] = i + ’0’;
34 i = temperature .low8 % 10;
35 bufferCOM [4] = i + ’0’;
36 tmp = tenths * 625;
37 i = tmp / 1000;
38 tmp %= 1000;
39 if (( tmp >= 500) && (i < 9))
40 i++;
41 bufferCOM [6] = i +’0’;
42 startSPI (9);
43 }
44 else
45 { // error message
46 bufferCOM [0] = ’T’;
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47 bufferCOM [1] = ’-’;
48 bufferCOM [2] = ’e’;
49 bufferCOM [3] = ’r’;
50 bufferCOM [4] = ’r’;
51 startSPI (5);
52 }
53

54 sleepWOC ();
55 startSPI (1);
56

57 if ( buttonPressed )
58 { // sending after button is pressed
59 copyBufferCOM2RF ();
60 pulseLEDR ();
61 PIN = 0;
62 DLEN = 9;
63 RFTXpacket ();
64 waitDelay (25);
65 }
66 }
67 }

Výpis F.4: Kód pre vysielač odosielajúci teplotu z interného čidla po stlačení tlačidla
na IQRF koordinátor (TeplotaTXIQRF.c)
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1

2 import time
3 import struct
4 from machine import SPI , Pin ,I2C
5 from ahtx0 import AHT20
6

7 # initialization of SPI bus
8 sck_pin = machine .Pin (10, machine .Pin.OUT)
9 mosi_pin = machine .Pin (11, machine .Pin.OUT)

10 miso_pin = machine .Pin (12, machine .Pin.IN)
11 cs_pin = machine .Pin (13, machine .Pin.OUT)
12

13 spi = SPI (1, baudrate = 20000 , polarity =0, phase =0, sck=sck_pin ,
mosi=mosi_pin , miso= miso_pin )

14 cs_pin .value (1)
15

16 # initialiyation of I2C bus
17 i2c1 = I2C (1, scl = Pin (15) , sda = Pin (14) , freq = 100000)
18

19 # initialization of temperature sensor
20 tmp_sensor = AHT20(i2c1)
21 tmp_sensor . initialize ()
22 temp= tmp_sensor . temperature
23

24 # function which reads temperature from sensor
25 def ReadTempOPT ():
26 time.sleep (0.5)
27 temp= tmp_sensor . temperature
28 temp =( temp +40) *10 # optimalization of temperature
29 print ("{:d}". format (int(round(temp , 0))))
30 time.sleep (1)
31 # foramting temperature ot xxx format
32 return "{:d}". format (int(round(temp , 0)))
33

34 # calculation of CRC
35 def calculate_crc ( hex_string ):
36 # Initialize XOR with F0 , 85, and 5F
37 xor_result = 0xF0 ^ 0x83 ^ 0x5F
38 for i in range (0, len( hex_string ), 2):
39 xor_result ^= int( hex_string [i:i+2], 16)
40 return xor_result
41

42 # function which creates SPI packet and after that packet is send
43 def SendTemp (temp):
44 hex_string = ’’.join(’{:02x}’. format (ord(c)) for c in temp)
45 crc_value = calculate_crc ( hex_string )
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46 message = f’f083{ hex_string }{ crc_value :02x}00 ’
47 byte_array = bytes. fromhex ( message )
48 formatted_string = ’’.join(’\\x{:02x}’. format (b) for b in

byte_array )
49 print(f" Formatted SPI Message : { formatted_string }")
50 spi.write( byte_array )
51

52 while 1:
53 temp = ReadTempOPT ()
54 cs_pin .off () #start of SPI communication
55 time. sleep_ms (10)
56

57 SendTemp (temp)
58 time. sleep_ms (10)
59

60 print(spi.read (20)) # reading of slave answer
61 time. sleep_ms (10)
62

63 cs_pin .on() # end of SPI comunication

Výpis F.5: Program pre dosku BPC-IoT s optimalizovaným tvarom pre teplotu
(Bonus.py)
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